# Table of Contents

1  **Overview** .......................................................................................................................... 1  
   1.1 MIPI Standards Supported .............................................................................................. 3  
   1.2 Differences Between the P344 and P338 ..................................................................... 3  

2  **Setup & Installation** ......................................................................................................... 5  
   2.1 Quick-Start Summary ..................................................................................................... 5  
   2.2 Installing DPhyGenCtl Software .................................................................................. 5  
   2.3 Connecting the DPhy Generator ................................................................................... 6  
   2.4 DPhy Generator Back-Panel Connector ......................................................................... 7  

3  **Common Command Data and Element Types** ................................................................ 8  
   3.1 Bytes ........................................................................................................................... 8  
   3.2 Integers ........................................................................................................................ 8  
   3.3 Byte or Integer Lists ................................................................................................. 8  
   3.4 DPhy LP States .......................................................................................................... 8  

4  **Operational Concepts** ....................................................................................................... 10  
   4.1 Pattern Generator (PG) ............................................................................................... 10  
   4.2 DPhy Bus Behavior ..................................................................................................... 10  
   4.3 Clock Lane Behavior ................................................................................................... 11  
      4.3.1 Non-Video-mode Clock Behavior .................................................................... 11  
      4.3.2 Video-mode Clock Behavior ............................................................................ 12  
      4.3.3 File Command Clock Behavior ........................................................................ 12  

5  **Using DPhyGenCtl** ........................................................................................................... 13  
   5.1 GUI Overview .............................................................................................................. 13  
   5.2 Generic List Dialog ....................................................................................................... 14  
   5.3 Connecting to the DPhy Generator ............................................................................. 15  
   5.4 Instrument Configuration ............................................................................................ 16  
      5.4.1 Main Window Configuration Controls ................................................................. 16  
      5.4.2 Instrument Configuration Dialog ....................................................................... 17  
   5.5 DPhy Timing Configuration ........................................................................................... 20  
   5.6 Commands .................................................................................................................... 22  
      5.6.1 Defining a New Command .................................................................................. 22  
      5.6.2 Naming a Command ........................................................................................... 23  
      5.6.3 Editing an Existing (Non-Macro) Command ....................................................... 23  
      5.6.4 Managing Commands (renaming, ordering, deleting) ...................................... 24  
      5.6.5 Saving/Restoring Command Configurations ..................................................... 24  

- Page ii -
5.6.6 VCX Field Support .......................................................... 24
5.6.7 Special Command Types .................................................. 24
  5.6.7.1 Video-mode Commands ............................................ 24
  5.6.7.2 Display Stream Compression (DSC) Video .................. 25
  5.6.7.3 Macros ..................................................................... 25
  5.6.7.4 Phy Commands ......................................................... 25
  5.6.7.5 File Command ......................................................... 25
  5.6.7.6 PG File Command .................................................... 26
  5.6.7.7 Script Commands ..................................................... 26
  5.6.7.8 Variable Argument Commands .................................. 26
  5.6.7.9 Long Data File Format Commands ......................... 27
  5.6.7.10 DCS Write Memory Commands .............................. 28
  5.6.7.11 LP Delay .............................................................. 31
  5.6.7.12 Delay To Pos ........................................................ 32
  5.6.7.13 Mark Zero Pos ....................................................... 32
  5.6.7.14 Wait Ext Event ....................................................... 32
  5.6.7.15 Assert Trigger ....................................................... 32
  5.6.7.16 Cmd Insertion Point .............................................. 33

5.7 Video-mode Commands ......................................................... 33
  5.7.1 Overview .................................................................... 33
  5.7.2 Video Command Definition .......................................... 34
    5.7.2.1 File Name Syntax ................................................. 34
    5.7.2.2 Frame Generation Using File Command Script .......... 37
    5.7.2.3 Video Error Syntax .............................................. 38
    5.7.2.4 Image Viewing Dialog ......................................... 38
  5.7.3 Frame Timing Dialog ..................................................... 39
    5.7.3.1 Frame Timing Configurations ................................. 40
    5.7.3.2 Frame Parameter Controls .................................. 41
    5.7.3.3 Clock Timing Controls ........................................ 41
    5.7.3.4 CSI Frame Construction Controls ...................... 41
    5.7.3.5 DSI Frame Construction Controls ...................... 42
    5.7.3.6 Common Frame Construction Controls .................. 43
    5.7.3.7 Stereoscopic Frame Controls ............................... 44
  5.7.4 Video Frame Construction Details ................................... 44
    5.7.4.1 Stereoscopic Frame Construction ......................... 45
    5.7.4.2 Command Insertion ............................................ 46
    5.7.4.3 Video Memory Requirements ............................... 46
  5.7.5 DSC Compression ......................................................... 46
    5.7.5.1 DSC Configuration Dialog .................................. 47
    5.7.5.2 Sending Compressed Frames in Video Mode .......... 49
    5.7.5.3 Sending Compressed Frames in Command Mode ...... 50
    5.7.5.4 Sending PPS Information ..................................... 50
    5.7.5.5 Compressing/Uncompressing Image Files ............ 50
    5.7.5.6 Viewing DSC Images ........................................... 51

5.8 Macros .................................................................................. 51
  5.8.1 Defining a New Macro ................................................... 51
5.8.2 Editing an Existing Macro ............................................................................ 53
5.8.3 Copying a Macro ........................................................................................... 53
5.8.4 Inserting a Component Command .............................................................. 53
5.8.5 Replacing a Component Command ............................................................ 54
5.8.6 Editing a Component Command ................................................................ 54
5.8.7 Allowed Component Commands ............................................................... 54
5.8.8 Video-Mode Commands In Macros ............................................................ 55
  5.8.8.1 “Enable Video Mode In Macros” Enabled ........................................... 55
  5.8.8.2 “Enable Video Mode In Macros” Not Enabled .................................... 55
5.8.9 Looping In Macros ...................................................................................... 56
5.8.10 HS Component Command Behavior ....................................................... 57
5.8.11 Additional Notes on Macro Behavior ....................................................... 57

5.9 Phy Commands ............................................................................................... 57
  5.9.1 Clock On / Clock Off .............................................................................. 58
  5.9.2 ULPS ......................................................................................................... 58
  5.9.3 BTA ......................................................................................................... 59
  5.9.4 Escape Command .................................................................................... 59
  5.9.5 Skew Calibration ...................................................................................... 59
  5.9.6 Alternate Calibration ................................................................................ 60
  5.9.7 TGR Data Sequence .............................................................................. 61
  5.9.8 TGR Bit Sequence .................................................................................. 61
  5.9.9 PRBS9 Sequence .................................................................................... 61
  5.9.10 PRBS11 Sequence ............................................................................... 62
  5.9.11 PRBS18 Sequence ............................................................................... 62

5.10 File Command ............................................................................................... 62

5.11 PG File Command ........................................................................................ 63
  5.11.1 Creating A PG File .............................................................................. 64
  5.11.2 Sending A PG File .............................................................................. 64

5.12 Command Buttons .......................................................................................... 64

5.13 Operation ....................................................................................................... 65
  5.13.1 Sending a Command ............................................................................ 65
    5.13.1.1 Stop PG ........................................................................................ 66
    5.13.1.2 Restart PG ................................................................................... 66
  5.13.2 Status ..................................................................................................... 66
    5.13.2.1 Contention Detection ................................................................. 66
    5.13.2.2 DUT Response .......................................................................... 67
  5.13.3 Command Insertion ............................................................................. 69
  5.13.4 Controlling TrigOut ............................................................................. 69
  5.13.5 External Event Triggering ................................................................. 70
    5.13.5.1 Controlling When Command Output Begins ......................... 70
    5.13.5.2 Controlling Frame Advance During Video Mode ................... 71
    5.13.5.3 Controlling Macro Component Command Output .............. 71
    5.13.5.4 Triggering the External Event Signal Via Software .............. 71
  5.13.6 Wait Events ........................................................................................... 71
5.13.7 Causing Packet Errors................................................................. 72
5.13.8 “Hold Trail” Test Mode .............................................................. 73
5.13.9 Script Recording ....................................................................... 73
5.13.10 Updating Firmware ................................................................. 73

5.14 Dual-Instrument Operation ............................................................ 75
5.14.1 Hardware Configuration ............................................................. 75
5.14.2 Software Initialization ............................................................... 75
5.14.3 Slave Server GUI ...................................................................... 76
5.14.4 Instrument Configuration .......................................................... 76
5.14.5 Operation ................................................................................. 76
5.14.6 Sending Video........................................................................... 77
  5.14.6.1 Image Partitioning ............................................................... 77
  5.14.6.2 Dual-Image Mode File Naming ............................................ 78
  5.14.6.3 Command Insertion Behavior ............................................ 78
5.14.7 Master/Slave RPC ................................................................. 79

5.15 Customizing GUI Colors ............................................................. 80

5.16 GUI Options ................................................................................ 81
5.17 Keyboard Shortcuts ..................................................................... 81
5.18 Menus ....................................................................................... 82

6 DPhyGenCtl RPC (Remote Procedure Calls) ....................................... 87
6.1 RPC Script Syntax Support ............................................................ 87
6.2 Sending RPC Scripts .................................................................... 88
6.3 Internal File Support ..................................................................... 88
<table>
<thead>
<tr>
<th>Contacting The Moving Pixel Company</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phone</strong></td>
</tr>
<tr>
<td><strong>Fax</strong></td>
</tr>
<tr>
<td><strong>Address</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Email</strong></td>
</tr>
<tr>
<td><strong>Web site</strong></td>
</tr>
</tbody>
</table>
1 Overview

The DPhyGenCtl application is the controlling software for the DPhy Generator (P344) made by The Moving Pixel Company (TMPC). Using this instrument, the user can generate CSI and DSI protocol and pattern stimulus on a MIPI DPhy bus for receiver testing, notably supporting the DPhy 1.2 specification. This document describes the use and operation of DPhyGenCtl and the corresponding behavior of the DPhy Generator.

For those familiar with earlier TMPC MIPI products, the DPhy Generator instrument is very similar in functionality to the P331/P332/P338 DPhy probe family. Unlike prior DPhy solutions that required use of a general-purpose pattern generator (PG3A), the DPhy Generator is a stand-alone instrument containing an internal pattern generator. Thus, it is the only custom hardware required for DPhy generation.

The DPhy Generator is connected via USB to a host computer that runs the DPhyGenCtl software. It has the following capabilities:

- Connects via either USB2 or USB3, allowing for fast program download times.
- Contains internal pattern generator with 2 GB of program memory
- Supports one to four DPhy lanes, supporting frequencies up to 2.6 Gb/s or 4.5 Gb/s (with purchase option)
- Can be synchronized with a second DPhy Generator within ~200 ps precision to provide 2x4 lane support.
- Lane outputs are via SMA connectors
- Provides up to ~4.5 ns of independent lane skew below 3.2 Gb/s. Provides ~320 ps of skew above 3.2 Gb/s.
- Provides real-time, per-lane, high and low HS voltage adjustments and common high and low LP voltage adjustments.
- Supports configuration and adjustment of DPhy bus timing.
- Provides 4 KB receive buffer for DUT response capture of LP data.
- Supports lane 0 LP contention detection.
- Implements arbitrary logical-to-physical lane output mapping.
- Provides a configurable Trig Out signal, which can be asserted via MIPI stream and/or software control.

The DPhyGenCtl application is a Windows application that embodies knowledge of MIPI CSI, DSI, and DPhy protocols to build programs for the DPhy Generator. Based on its predecessor software, PGRemoteForP338, it provides the following functions:

- Comprehensive video support:
  - Support for 3D stereoscopic frame construction (DSI 1.2).
- Purchase option for encoding and sending of DSC video frames (DSI 1.2).
- Common source input image file formats (jpg, png, tiff, gif), used for both video-mode and Write Memory commands.
- Automatic resizing of input images (in software) to fit display or camera dimensions.
- Basic test pattern generation via naming syntax (syntax dialog provided).
- Convenient image preview function in GUI.
- Automated CSI/DSI video-mode frame generation based on user frame timing.
- Automatic partitioning of single Write Memory command into a multiple Write Memory command sequence.
- Video-mode frame support in macros.
- Single-bit error insertion at a given line and bit position into video-mode frames.

**Generic File command support:**
- Uses text file description to describe mixed low-level LP/HS transitions and packet definition.
- Allows nearly-arbitrary data lane signal generation for conformance testing.
- Provides higher-level embedded commands for easy command definition, including HS burst entry, HS burst exit, clock on, clock off sequences. Also, automatic ECC and CRC generation.
- Supports nested files for reuse of common definitions.
- Supports variables, expression evaluation, and subroutines for stream construction and test data generation.

**Support for low-level Phy testing:**
- Low-level test HS burst sequences using user-defined or PRBS data.
- User configuration of bus timings, e.g. HSPrepare, HSZero, HSTrail, HSExit, etc.
- New flexible bus timing specification in component units of ns, UI, and TLPX, allowing for frequency agile configurations.

**Support for dual-instrument operation for synchronized 2x4 lane systems.**
Includes the ability to send left/right split-image video sequences out master/slave instruments respectively.

**Powerful and easy-to-use GUI controls for command manipulation:**
- Simple definition, naming, and sending of commands, including video-mode commands.
- Push-button interface for assigning and organizing commands so they are available for single-click sending.
- Macro definition for building and complex command sequences.
- Provides named frame timing configurations and DPhy timing configurations.
- Provides dialogs to reorder/delete/sort named command, frame timing, and DPhy timing drop-down lists.

**Automation Support:**
- Script command allows text file usage for: configuration, command/macro/program definition and output.
- Remote-control capability via .NET DLL.
1.1 MIPI Standards Supported

The DPhy Generator and DPhyGenCtl were originally designed to support the following MIPI standards up to 2.6 Gbps (or 4.5 Gbps with purchase option):

- CSI2 1.3
- DSI 1.3.1
- DPhy 1.2
- DSC 1.2 (purchase option)

However, protocol extensions for DSI2 1.0, CSI2 2.0 and DPhy 2.1 have been made, including the following features:

- DSI packet scrambling (DSI2 1.0)
- CSI per-lane scrambling (CSI2 2.0)
- Alternate Calibration Sequence (DPhy 2.1)
- Preamble Sequence (DPhy 2.1)
- VCX extension field (CSI2 2.0)
- Raw 16 and Raw20 video modes (CSI2 2.0)

Notable features that are NOT currently supported in the instrument are:

- HS RX support (1/4 rate) on any lane
- LP RX support on lanes 1-3
- Contention detection on lanes 1-3
- xN sublink support
- Video-mode support for FSC transactions (frame-synchronized commands)
- Transmit equalization /de-emphasis
- Spread-spectrum clocking
- LRTE (latency reduced transport efficiency)

1.2 Differences Between the P344 and P338

For convenience, this section summarizes the major differences and improvements between the P338 / PGRemoteForP338 and the P344 / DPhyGenCtl solutions.

In general, usage, structure, and behavior are very similar between the two solutions. Anyone familiar with using PGRemoteForP338 will have no trouble understanding how to use DPhyGenCtl. For the most part, the capabilities of the P344 solution is a superset of the capabilities of the P338 solution, although the two are not always directly compatible. In particular, configuration file formats and File command syntax are not
interchangeable. Also, while RPC command support and scripting syntax are nearly identical, there are exceptions.

Table 1 and Table 2 summarize the major differences in capabilities and characteristics of the two solutions.

### Table 1 – P338 versus P344

<table>
<thead>
<tr>
<th>Capability</th>
<th>P338</th>
<th>P344</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Bit Rate</td>
<td>1.6 Gbps</td>
<td>2.6 or 4.5 Gbps</td>
</tr>
<tr>
<td>Maximum Data Lane Count</td>
<td>4 or 8 (option)</td>
<td>4</td>
</tr>
<tr>
<td>Additional HW Required</td>
<td>PG3A</td>
<td>None</td>
</tr>
<tr>
<td>Host Communication</td>
<td>USB2 @ 30 MB/s</td>
<td>USB3 @ 200 MB/s</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>256 MB (in PG3A)</td>
<td>2 GB</td>
</tr>
<tr>
<td>Memory Usage (maximum HS data per data lane)</td>
<td>32 MB</td>
<td>Max 1.5 GB (1 lane), Max 1.0 GB (2 lanes), Max 500 MB (3, 4 lanes)</td>
</tr>
</tbody>
</table>

### Table 2 – PGRemoteForP338 versus DPhyGenCtl

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>PGRemoteForP338</th>
<th>DPhyGenCtl</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSI version support</td>
<td>1.1</td>
<td>1.3.1</td>
</tr>
<tr>
<td>Stereoscopic frame support?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>DSC compressed video support?</td>
<td>No</td>
<td>Yes (purchase option)</td>
</tr>
<tr>
<td>Video-mode frames allowed in macros?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Video-mode frame bit error control?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TGR and PRBS sequences for low-level Phy support?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Named DPhy Timing Configs?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Named Frame Timing Configs?</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Video Decimation?</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Dual-interface support?</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Clock On/Off Model</td>
<td>Cumbersome</td>
<td>Simplified</td>
</tr>
<tr>
<td>File command support</td>
<td>Lacking mixed LP/HS signaling</td>
<td>Comprehensive, including mixed LP/HS signaling</td>
</tr>
<tr>
<td>DPhy Timing Specification</td>
<td>Units of ns only</td>
<td>Frequency-aware with units of ns, UI, and TLPX.</td>
</tr>
</tbody>
</table>
2 Setup & Installation

2.1 Quick-Start Summary

The following summarizes the overall procedure for installing and configuring the TMPC software and hardware for DPhy testing:

- Install DPhyGenCtl Software (section 2.2)
- Set up, connect, and power on the DPhy Generator (section 2.3)
- Launch DPhyGenCtl and connect to the DPhy Generator instrument (section 5.3)
- Select the MIPI standard to use: CSI or DSI (Standard menu)
- Configure instrument operational parameters (section 5.4).
- Configure video timing parameters for your device (section 5.7.3)
- Configure DPhy bus timing and protocol definitions.(section 5.5)
- Define commands and assign them to buttons, if desired (section 5.6.1).

Once these steps are completed, the system is ready to start testing.

2.2 Installing DPhyGenCtl Software

System requirements for the DPhyGenCtl application are as follows:

- Installation must be on a Windows PC running XP, Win7, Win8, or Win10
- Both 32-bit and 64-bit processors are supported but only 64-bit processors can take advantage of the full 1 GB memory in the DPhy Generator. Host computers with 32-bit processors or with limited memory (< 4 GB) will be limited to approximately 256 MB of program memory in the DPhy Generator.
- A USB2 or USB3 port is required to communicate with the DPhy Generator instrument. Using a USB3 port is highly recommended for program download speed.

To install DPhyGenCtl, simply execute the installation file “DPhyGenCtlNstall.exe” on the installation CD and step through the setup windows. As part of the installation, a USB driver is installed called CyUSB3.sys. This driver is required for the software to recognize the DPhy Generator instrument when connected to USB.

Periodically, new versions of DPhyGenCtl are available on the Moving Pixel Company web-site at the following link:

Simply download, unzip and run the DPhyGenCtlNstall.exe program. Note that the previous version is automatically uninstalled when running installation of an upgrade version of DPhyGenCtl.

The DPhyGenCtl application is installed by default in:

- `c:\Program Files\TMPC\DPhyGenCtl` (32-bit computers)
- `c:\Program Files (x86)\TMPC\DPhyGenCtl` (64-bit computers)

The following shortcuts are provided in the Start Menu, under DPhyGenCtl

- **DPhyGenCtl.exe**: a link to the application executable
- **DPhyGenCtlUsersManual_x_x.pdf**: link to this manual
- **DPhyGenCtlRPC_x_x.pdf**: RPC manual for instrument remote control
- **DPhyGenCtlRPCCommands_x_x.pdf**: RPC command summary
- **DPhyGenCtlRPCTest**: sample Visual Studio project demonstrating remote control
- **Uninstall.bat**: a link for uninstalling the application

Once the software has been installed for the first time, the license file named “TMPCLicense.txt” (obtained from The Moving Pixel Company) should be copied to the application directory. The license file enables DPhy operation (and perhaps other options in the future) based on the serial number of your DPhy Generator. Note that the software may be installed on, and the license file copied to, multiple host machines.

If a license file (or the correct license string in the license file) is not present, the software can still run in offline mode. This mode allows the user to interact with the GUI, define and save commands, and develop RPC applications without connecting to real hardware.

### 2.3 Connecting the DPhy Generator

The DPhy Generator is straightforward to set up, significantly more so than its predecessor probes without the need of the PG3A pattern generator connections.

- Connect the 24V power supply adaptor to the instrument.
- Connect a USB cable from the host machine to the instrument. Note: a USB3 cable is required to connect to the DPhy Generator. However, either a USB3 or USB2 port on the host computer can be used for connection (although USB2 operates at reduced speed). A USB3 port is distinguished from USB2 by its blue color.
- Connect your DUT to DPhy lane outputs via SMA cables.
- Power on the instrument

After power-on, assuming the CyUSB3 driver is installed, the instrument appears in the device manager of the host machine as “P344 DPhy Generator”. At this point launching
DPhyGenCtl should show the instrument serial number in its Connect dialog, ready for use.

### 2.4 DPhy Generator Back-Panel Connector

For an overall description of the P344 DPhy Generator hardware, please see the P344 datasheet. However, for reference in this document, the back-panel connector pin-out is shown in Figure 1.

Currently, only some of the pins are used on the back-panel connector and note that no back-panel connections are required for normal operation, unless external events are to be used for program control.

The pins currently used are:

- **Evt0** – indicates when command insertion occurs
- **Evt1** – indicates lane 0 contention (OR of all the four contention flags)
- **GPI0** – external event input for program flow control
- **GPO0** – TrigOut from host or stream

Remaining signals on the connector are unused.

![Figure 1 — P344 Back-Panel Connector](image-url)
3 Common Command Data and Element Types

Various data and element types are used in the DPhyGenCtl application, whether as parameter arguments to GUI commands, script commands, or component commands of a text file used in the File Command. This section describes common data and element types and how to specify them.

3.1 Bytes

Bytes are 8-bit integer values ranging from 0 to 255 and can be specified in decimal or hexadecimal. Unless otherwise specified for a particular command, the default radix for command byte arguments is decimal. If a command indicates it uses “hex byte” arguments, then the default radix is hexadecimal.

To explicitly define the radix of a data byte, append either a ‘d’ for decimal or ‘h’ for hexadecimal. For example, the following list describes a 4 byte sequence from 16-19 inclusive:

   16 11h 18d 13h

3.2 Integers

Integers are 32-bit signed integer values and can be specified in decimal or hexadecimal (in which case the value is always non-negative). Unless otherwise specified, the default radix for integer arguments is decimal.

To explicitly define the radix of an integer, append either a ‘d’ for decimal or ‘h’ for hexadecimal. For example, the following list describes a 4 integer sequence from 256-259 inclusive:

   256 101h 257d 103h

3.3 Byte or Integer Lists

Some commands allow parameters to be byte or integer lists. These lists are specified by one or more byte or integer values respectively, separated by spaces (see previous two sections for examples). The argument name for this value is usually Params[], which usually requires byte values unless otherwise indicated by the specific command.

3.4 DPhy LP States

DPhy LP states represent low-power voltage levels for the two wires of a lane and have integer values ranging from 0-3. The wire-order for LP states is (LP+, LP-): 0 (LP00), 1 (LP01), 2 (LP10) and 3 (LP11).

Some commands encode the LP state for all four data lanes plus the clock as a 10-bit hex value. The argument name for this value is LPValue[9:0]. For this argument, each pair of bits in LPValue contains the LP state for a corresponding lane as follows:

- LPValue[1:0] – LP State for lane 0
- LPValue[3:2] – LP State for lane 1
- LPValue[9:8] – LP State for clock lane

Note that if the clock is running when a command that sets the LP state is sent, the clock lane remains running and the LPValue bits for the clock are ignored.
4 Operational Concepts

4.1 Pattern Generator (PG)
As previously mentioned, prior MIPI solutions offered by The Moving Pixel Company have used a general-purpose pattern generator (PG3A) and a MIPI-specific probe (P331, P332, P338) for DPhy stream generation. The P344 DPhy Generator streamlines this architecture by incorporating the pattern generation function into the instrument. Thus, the PG3A is no longer required.

However, this document and the DPhyGenCtl software still refer to the PG as a distinct (internal) component of the DPhy Generator. For example, the status pane in the main window shows whether the PG is running or idle, and buttons labeled “Stop PG” and “Restart PG” are used to control the DPhy Generator’s internal pattern generator engine for transmission.

4.2 DPhy Bus Behavior
Once the DPhy Generator has been powered on and DPhyGenCtl is connected, DPhy lanes including the clock lane are driven to LP11. This is the default state of the instrument whenever the PG is idle. Note that this behavior is different that previous MIPI probes (P331, P332, P338), which allowed the clock to continue to run when the PG was idle. See the next section for further discussion of clock lane behavior and control.

When commands are sent using DPhyGenCtl, one or more lanes become active, either transitioning to HS mode or signaling in LP mode, depending on the command and the current “DT Mode” setting. Generally, the “Lane Cnt” setting determines which lanes become active, though it is possible for the low-level commands to send LP data on any number of lanes, independent of “Lane Cnt”.

The Options->Loop Commands menu option determines whether commands are sent once or looped on the bus indefinitely. If this option is not checked, the command is sent and then the bus returns to the LP11 state, with the PG status indicating that it is idle. Otherwise, PG status indicates it is Running while the command is looping.

Note that some lower-level Phy commands inherently loop the PG, regardless of the “Loop Commands” setting. These include “Enter Ultra Low-Power Mode” and the TGR and PRBS test sequence commands.

Looping commands can be stopped by clicking the “Stop PG” button, returning the PG to idle state and the DPhy bus to LP11. Also, unless command insertion is enabled (Options->Enable Command Insertion), sending another command while a command is
looping causes the application to ask whether you want to stop the PG to allow the sending of the command.¹

### 4.3 Clock Lane Behavior

This section describes the behavior of the clock lane, which can be turned on/off according to the DPhy protocol. The only direct requirement of the clock lane is that it runs during HS bursts, but otherwise users have differing requirements on whether the clock should remain on during LP traffic.

One overarching behavior enforced by software is that the clock is always off (i.e. in the LP11 state) when the PG is idle. Thus, the clock is always off when sending a new command and it is always turned off (if necessary) when a command completes.

#### 4.3.1 Non-Video-mode Clock Behavior

For non-video-mode commands, clock lane behavior is further governed by two options (Options menu):

- “Turn Clk On When Sending Non-Video Cmds”
- “Turn Clk Off After HS Burst (Non-Video)”

plus some other behavioral rules:

- The clock is automatically turned on (if necessary) whenever an HS command is sent
- The clock is turned on (if not already on) when a “Clock On” command is encountered in a macro.
- The clock is turned off (if not already off) when a “Clock Off” command is encountered in a macro.

These rules and options define the clock lane behavior for all non-video commands.²

The option “Turn Clk On When Sending Non-Video Cmds” causes the clock to turn on before a non-video command is sent. This option really only determines how the clock behaves when an LP command is sent (or a macro that starts with an LP command), as the clock automatically turns on if the command is an HS command anyway (or is a macro that starts with an HS command).

Similarly, the option “Turn Clk Off After HS Burst (Non-Video)” causes the clock to turn off after an HS command is sent. This option is only relevant for HS commands in macros (as the clock automatically turns off at the end of an HS command anyway).

---

¹ Unless the GUI option “Suppress confirmation message when stopping PG” is set, in which case the looping command is automatically stopped.
² Note that the File command is the one exception to this rule as it has its own clock on/off component commands.
Generally, the user desires one of two behaviors:

1. The clock turns on and remains on throughout all commands, including LP commands. In this case the user should check “Turn Clk On When Sending Non-Video Cmds” and uncheck “Turn Clk Off After HS Burst (Non-Video)”.

2. The clock is turned off for LP commands. In this case the user should uncheck “Turn Clk On When Sending Non-Video Cmds” and check “Turn Clk Off After HS Burst (Non-Video)”.

Other distinct behaviors can be controlled using the “Clock On” and “Clock Off” commands in macros.

4.3.2 Video-mode Clock Behavior

In video-mode, clock behavior is simply controlled through a single option in the Frame Timing dialog: “Turn Clk On/Off During LP11 Blanking”. When this option is checked, the clock turns off at the start of LP11 blanking and back on again at the end of LP11 blanking. If the option is unchecked, the clock remains on throughout video playback.

Note that video-mode frames added to macros keep this same behavior, even as non-video clock behavior rules and options (see previous section) are applied to other non-video-mode commands in the macro.

4.3.3 File Command Clock Behavior

The File command specifies a user provided text file to control LP and HS signaling and send arbitrary packet data. However, some of the component commands only apply to data lane output and do not affect the clock lane, in particular, those related to HS output. In this case, the clock lane maintains its current state throughout these commands, whether in LP11 or oscillating.

Special component commands CLK_ON and CLK_OFF can be used to turn the clock on and off, following the proper DPhy protocol and using the current DPhy timing configuration. Otherwise, for more extensive non-standard clock lane testing in HS mode, the user can take advantage of the lane-mapping capability of the DPhy Generator, e.g. data lane 0 output can be mapped to the clock lane.
5 Using DPhyGenCtl

The DPhyGenCtl software is the configuration and control application for the DPhy Generator. Using its GUI interface, users can interact with the instrument, configuring commands to send on the bus, monitor status and review DUT response data. In addition, the application supports a remote-control interface (called RPC) that supports controlling nearly all capabilities accessible through the GUI using a remote, user program.

![Figure 2 – DPhyGenCtl Main Window](image)

5.1 GUI Overview

Most of the interaction between the user and DUT occurs in the DPhyGenCtl main window (see Figure 2). It has several distinct sections.
The left pane of the main window allows the user to define commands and their arguments, naming them to allow for later recall and sending to the DPhy Generator, as well as assigning them to command buttons.

The right pane of the main window consists of four tab pages with 30 command buttons each that can each be individually associated with a named command, allowing single-click sending of commands to the DPhy Generator.

The bottom left pane of the main window provides controls for configuring parameters of instrument transmission, video timing definitions, physical characteristics of the DPhy bus, and trigger events.

The bottom right pane of the main window shows instrument status and provides operational controls.

The status bar at the bottom of the main window displays informational and error messages and indicates the current instrument connection and software/firmware versions.

The following sections describe more details of DPhyGenCtl operation.

5.2 Generic List Dialog

The generic List dialog is used to organize named item lists associated with a drop-down control. Named items are listed in a central list-box, with controls on the side to manipulate items in the list. The List dialog supports the follow functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear the list</td>
<td>Click on the Clear button</td>
</tr>
<tr>
<td>Sort the list alphabetically</td>
<td>Check the Sort checkbox</td>
</tr>
<tr>
<td>Reset the list to its default</td>
<td>Click the Defaults button</td>
</tr>
<tr>
<td>Delete items in the list</td>
<td>Select one or more items in the list and click the Delete button</td>
</tr>
<tr>
<td>Move item(s) up in the list</td>
<td>Select one or more items in the list and click the Up button</td>
</tr>
<tr>
<td>Move item(s) down in the list</td>
<td>Select one or more items in the list and click to Down button</td>
</tr>
</tbody>
</table>

After viewing and/or modifying the list, clicking OK closes the dialog and records any changes. Clicking Cancel closes the dialog and discards any changes to the list.

A List dialog is associated with three controls in DPhyGenCtl:

- Cmd Name control in the main window
- Frame Timing Configuration control in the Frame Timing dialog
- DPhy Timing Configuration control in the DPhy Timing Configuration dialog
Immediately to the right of each of these controls is a button labeled with an ellipsis (“…”). Clicking this button brings up the List dialog, initialized with element names from the associated control. Figure 3 shows an example Frame Timing List dialog.

![Figure 3 – Frame Timing List Dialog](image)

### 5.3 Connecting to the DPhy Generator

Before any commands can be sent, the DPhyGenCtl application needs to connect to the DPhy Generator connected via USB to the host machine. The appropriate license file for the instrument must be located in the application directory for successful connection (see section 2.2).

![Figure 4 – Connection Dialog](image)
When DPhyGenCtl is launched, the application automatically brings up a connection dialog (see Figure 4) with a drop-down control showing visible DPhy Generator instruments available for connection. An alternative way to bring up this dialog once the application is running is via the “Connect…” menu option in the Connect menu.

To connect to an instrument or change connection to a different instrument, select the serial number of the instrument you want to connect to and click OK. Select “Offline” to run in offline mode without an instrument connection. Clicking the Cancel button maintains the current connection state. Once the dialog is closed, the instrument serial number and firmware version is displayed in a bottom-right corner of the status pane to indicate the current connection. Otherwise, “Offline” is displayed.

If an instrument is not powered on and connected via USB before this dialog is launched, the Scan button can be used to show newly available instruments.

Also, if an instrument’s firmware has been corrupted and does not boot properly, it is important to check “Firmware update only” when connecting to the instrument for the purpose of updating its firmware. This disables communication with the central FPGA, which may not respond properly if it is in a bad state. After connecting to the instrument in this way, please proceed directly to the Update Firmware dialog (Connect menu) without other main window control interactions.

When testing is complete, the "Disconnect" menu can be used to close the instrument and return to offline. The application does this automatically on closing so it is not required.

5.4 Instrument Configuration

There are two main sets of controls for instrument configuration. The main window contains the most important and commonly adjusted controls such as LP frequency, HS bit-rate, lane count, and DT Mode. Less used controls can be found in the Instrument Configuration Dialog.

5.4.1 Main Window Configuration Controls

Four controls in the “Config” tab at the bottom of the main window are used to describe principal DPhy configuration parameters. These controls are described below:

**Act Link(s)**: this combo box selects which instrument (or both) is active in a dual-instrument system. Dual-instrument systems are supported with revision B hardware of the P344. When the active links control is set to “Master” or “Slave”, commands are only sent out on the selected instrument. When the active links control is set to “Master/Slave”, identical commands are sent synchronously out both instruments. Video commands have the option to split image frames across master and slave (i.e. in left/right image mode).

**DT Mode**: this combo box sets the default data transfer mode for commands whose DT Mode field is set to “Default”. Packets may be sent as either HS packets (HSDT mode)
or LP packets (LPDT mode). Individual commands can override the default DT Mode setting by setting the DTMode field in their command arguments. Note: this mode only applies to non-video commands and does not affect video-mode operation or low-level DPhy commands such as escape commands as well as the PRBS/TGR test sequences.

**HS Bit Rate:** This control sets the lane bit rate of the DPhy bus for all commands except video-mode commands. The supported range for the HS Bit Rate setting of the DPhy Generator is 31.25 Mbps to 4500 Mbps.

When playing non-video-mode commands, changing this control setting does not immediately affect the bit rate. Instead it schedules a frequency reconfiguration for the next sent command. To see the current bit rate on the DPhy bus for a running program, look at the HS Bit Rate display in the status pane **not** the HS Bit Rate setting in the instrument configuration pane.

When playing video-mode commands, the HS Bit Rate control is made read-only and reflect the current video-mode bit rate. This is to eliminate possible confusion with the HS Bit Rate setting (which applies only to non-video commands).

**LP Freq:** This control sets the frequency of LP bits on the DPhy bus (i.e. determines $T(LPX)$ in the DPhy standard). The supported range is 0.2 MHz to 30 MHz.

**Lane Cnt:** This control selects the number of DPhy lanes to use (1-4). HS packet data is demultiplexed onto DPhy lanes according to the DSI/CSI protocol specification. Unused lanes are held in the LP11 output state.

### 5.4.2 Instrument Configuration Dialog

Once connected, the DPhy Generator can be configured with parameters specific to the users testing needs via the Instrument Configuration dialog brought up from the main window via the "Inst Cfg..." button in the lower-left pane (Config tab) of the main window. Note that adjustments can be made even while a program is running.

After entering desired settings on the dialog, click the OK button to accept them or Cancel to discard them. Since settings are updated as they are adjusted, Cancel in this case means setting control values back to their values before the dialog was opened. Clicking on the Defaults button sets all controls to their default values.

Figure 5 shows the Instrument Configuration dialog. Below is a description of its controls:

**Force Test Pattern:** Checking this box causes a clock test HS bit pattern to be output on all DPhy lanes at the current HS Bit Rate setting. This mode is generally used while the

---

3 Video-mode commands follow the currently selected frame timing configuration, which sets the HS Bit Rate for the video command.

4 The HS Bit Rate used for the test pattern is the last configured bit rate, which may be different than the main window HS Bit Rate setting if it has been changed since the last command.

instrument is connected to an oscilloscope to ensure the instrument is working properly and to visually adjust voltages and delays for calibration.

**Common HS Voltage**: this check box, when checked, disables the HS voltage controls for all lanes except for lane 0. Adjustments to data lane 0 HS voltages are automatically applied to all lanes. Otherwise, HS voltage settings can be independently adjusted.

**Link to slave**: this check box, when checked, mirrors any settings in this dialog to the slave instrument. This control is only enabled when a slave instrument is connected.

**Slave Cfg…**: this button, when pressed, brings up the Instrument Configuration dialog for a connected slave instrument. This control is only enabled when a slave instrument is connected.

---

**Figure 5 – Instrument Configuration Dialog**

**HS Low/High Voltage Controls**: these controls set the *unterminated* HS voltage levels for DPhy lanes. When connecting to real hardware, HS voltages generally should be set
to 0.0V (low) and 0.4V (high). Slave termination resistance reduces HS levels to the expected swing of 0.1 - 0.3V. HS voltage limits for RevA instruments are -0.2V and 0.61V with a maximum unterminated amplitude of 0.61V. HS voltage limits for RevB instruments are -0.4V and 1.05V with a maximum unterminated amplitude of 1.2V.

Note that voltages settings below 0.0V on RevA instruments are uncalibrated (i.e. may have less accuracy than voltages above 0.0V). Software will indicate uncalibrated settings in red and “Uncal HS Volt” will be displayed in the right side of the status bar.

**LP Low/High Voltage Controls**: these controls set the LP voltage levels for all DPhy lanes. LP voltages generally should be set to 0.0V (low) and between 1.1V and 1.3V (high). LP voltage limits are -0.28V and 1.8V.

**HS Delay Controls**: these controls set the relative delays of each lane. Delay adjustments are in ps and have two limit maximums:

1. Max delay is 4800 ps for bit rates less than 3 Gbps
2. Max delay is 320 ps for bit rates greater than 3 Gbps

Be aware that when the bit rate is increased past 3 Gbps, existing delay values are automatically clipped to the new maximum delay (320 ps).

**Auto-Set Clk Dly**: this checkbox enables the automatic setting of clock delay to the ideal clock-to-data sampling delay for the current HS Bit Rate. When checked, the clock delay control is made read-only and reflects the automatic delay value. When unchecked, the clock delay control is user settable.

**LP Contention Thresholds**: these two controls determine the threshold voltage used for contention detection.

The LP Low contention threshold determines the voltage at which a LP Low fault is flagged (i.e. when the transmitter attempts to drive an LP0 and measures a voltage on the line greater than the threshold). This value is nominally 0.45V according to the DPhy specification.

The LP High contention threshold determines the voltage at which a LP High fault is flagged (i.e. when the transmitter attempts to drive an LP1 and measures a voltage on the line less than the threshold). This value is nominally 0.55V according to the DPhy specification.

**BTA Wait Time**: (not applicable for CSI) this control sets the time-out period after a BTA is sent to wait for a return BTA sequence from the DUT. Normally, if a return BTA is seen, the instrument acknowledges the BTA and continues its program. Similarly, if the time-out period expires, the instrument reasserts LP11 on lane 0 and continues its program.
**Trig Pulse Width:** set the trigger pulse width when a trigger pulse is sent on the TrigOut signal of the instrument, either through the “Assert Trigger” command in a program or the “Trig Event” button in the main window.

**Phy Lane 0 Src:** sets the logical source lane for physical lane 0. While normally, this is set to zero, this control allows logical lane 1, 2, 3, or Clk to be output on physical lane 0 as well. Note, however, that BTA handshaking, DUT response acquisition and contention detection is always is associated with physical lane 0 regardless of logical mapping.

**Phy Lane 1 Src:** sets the logical source lane for physical lane 1. While normally, this is set to one, this control allows logical lane 0, 2, 3, or Clk to be output on physical lane 1 as well. One use of this control is to duplicate lane 0 traffic on lane 1 for separate scope monitoring during single-lane mode communication.

**Phy Lane 2 Src:** sets the logical source lane for physical lane 2. While normally, this is set to two, this control allows logical lane 0, 1, 3, or Clk to be output on physical lane 2 as well.

**Phy Lane 3 Src:** sets the logical source lane for physical lane 3. While normally, this is set to three, this control allows logical lane 0, 1, 2, or Clk to be output on physical lane 3 as well.

**Clk Lane 3 Src:** sets the logical source lane for the clock lane. While normally, this is set to Clk, this control allows logical lane 0, 1, 2, or 3 to be output on physical lane 3 as well.

**Defaults:** button to reset all controls to their defaults. The user is prompted via a message box to confirm the reset operation.

### 5.5 DPhy Timing Configuration

The DPhy Timing Configuration Dialog (Figure 6) provides controls for the user to specify DPhy bus timings. Please see the DPhy specification for details of timing parameter definitions.

At the top of the dialog is a drop-down list of named timing configurations. A single configuration named “Default Timing” is pre-defined for the user, which sets reasonable, legal time constraints of each of the parameters.

Custom configurations can be defined by modifying any of the parameter fields. When a field is modified, the configuration name generally changes to “<custom>” and a text label “Modified” appears in the upper right corner of the dialog (though, if all fields match an existing named configuration, the matching configuration name is instead shown and the “Modified” label does not appear).
Click the Save button to save the custom configuration as a named configuration. The user is prompted for a configuration name, which is added to the drop down list control. Named timing configurations can be organized using the generic list dialog, brought up with the button labeled with an ellipsis ("…") next to the drop-down configuration list control. See section 5.2 for more information about the generic list dialog.

Note that a configuration does not have to be named and saved to be used. Current parameter settings in the dialog are used to configure command timing regardless of
whether part of a named configuration. In addition, current parameter settings are
automatically saved and restored when the application is closed and reopened.

For each timing parameter, three columns of text boxes allow timing definition in units of
ns, UI, TLPX. Some parameters have their TLPX or UI text boxes disabled for
component settings that are not supported. A column of text boxes labeled “Actual”
shows the resulting value that can be implemented, computed from the combination of
the component values and quantized to a multiple of 2*UI.

Note that the SkewCal and AltCal settings are used as the default duration settings for the
Skew Calibration and Alt Calibration commands. They are used when the UI argument
for these commands is 0.

The Preamble Sequence is an optional data pattern defined in DPhy 2.1 that follows
HSZero in a burst. It consists of a clock pattern ‘1010…’ of user-defined length followed
by an extended sync pattern of 0xff sent on each active lane. It is generally intended for
fine-tuning of clock-to-data skew at high speeds (greater than 2.5 Gbps).

This sequence can be enabled in the DPhy Generator by checking “Enable Preamble Freq
(Mbps)” and entering a threshold frequency. The sequence length is set using the Set
(UI) control for the Preamble.

5.6 Commands

5.6.1 Defining a New Command

Commands are defined using the left pane controls of the main window and are grouped
based on the current standard according to category. Thus, before defining a command,
the user should select the desired protocol via the Standard menu, currently either CSI or
DSI. Then, to define a new command, perform the following steps:

3. Select the command type via the “Pkt Type” drop-down control hierarchical
   menu. Note that once a command field is edited, the label in the “Cmd Name”
   control changes to "<New Cmd>" and “MODIFIED” appears below the command
   fields to prevent confusion with any existing command definition.

4. If the command type is a DCS command from the DSI command set (i.e. DCS
   Short Write, DCS Long Write, or DCS Read Request), the DCSCmdDesc drop-
   down control is enabled and the DCS command type is filled in.

5. Depending on the command selected, argument fields are labeled and enabled for
   the user to enter values. Certain arguments are pre-filled such as the virtual
   channel, DT Mode, and BTA. The user may change these pre-filled values if
   desired.

6. Commands that support sending either as a LP or HS command initially have
   their DTMode argument set to “Default”, which means the command is sent using
   the current default DT Mode setting (DT Mode control in the lower-left of the
main window). Alternatively, the user can specify the DTMode for certain commands by changing the DTMode argument to either LPDT or HSDT.

7. Setting BTA to “Yes” requests that a bus-turn-around sequence follow the sending of the command. This is usually used for read commands to allow the device under test to respond with data.

8. Numeric fields are assumed to be decimal unless appended with ‘h’ (hexadecimal) or ‘b’ (binary). For example “67h” = 103 and “1101b” = 13.

9. For most commands, derived fields of the command are displayed in read-only text boxes: DataID, WordCount, ECC, and CRC. The ECC and CRC fields can be modified to cause packet errors by checking the checkbox associated with the field, then editing the field. The other read-only fields cannot be modified directly by the user but are computed according to the MIPI specification based on the command arguments. Note that special commands such as video commands, Phy commands, script commands, File commands, etc. do not fill in these fields because they do not represent a single MIPI protocol packet.

5.6.2 Naming a Command

Once command’s argument fields are defined, the command may be named so that it can be assigned to a command button and saved in a configuration file. To name a command, click on the Save button to bring up a dialog to enter the command name. In the naming dialog, the command name field is initialized with the original command name present before editing. This allows the user the option to simply click OK to replace the original command. Otherwise, type in a new name to create a new command.

Named commands show up in the “Cmd Name” drop-down control in the main window. Selecting a named command in the list fills in the argument field controls with values associated with the command.

5.6.3 Editing an Existing (Non-Macro) Command

An existing non-macro command definition can be edited as follows:

- Load the command field values into the edit controls either by right-clicking on a button having a command assignment and selecting "Edit Current Command" or selecting the command name from the “Cmd Name” drop-down control.
- Edit the command fields.
- Click the Save button.
- Click OK in the naming dialog.
- Click OK in the confirmation dialog to replace the existing command definition.

---

5 To modify read-only fields, the user can use the “Send Cmd To File” menu option (File menu). This outputs the command bytes to a text file that can subsequently be modified and resent using the File command.

6 The confirmation dialog can be disabled in the GUI Options dialog (Options->GUI Options).
Macro editing is described in Section 5.8.2.

5.6.4 Managing Commands (renaming, ordering, deleting)
The button labeled with an ellipsis (“…””) immediately to the right of the “Cmd Name” drop-down control allows the user to manage the named command list, including renaming commands, reordering and sorting commands in the drop-down list, deleting commands, etc. Click this button to bring up a List dialog to perform these functions. See section 5.2 for more information about this dialog.

5.6.5 Saving/Restoring Command Configurations
A “default.cfg file” is provided with DPhyGenCtl installation that has a few example commands defined. Once you add new command definitions, you can save your command configuration, command set, and button assignments in a configuration file.

Note that command definitions and button assignments are not automatically saved when the application is closed. Use the "File->Save XXX.cfg As..." menu option and specify the name of the file to save to. Similarly, you can load a configuration file with the "File->Load..." menu option. The last configuration file saved before exit is restored when the application is restarted.

5.6.6 VCX Field Support
The CSI2 2.0 standard extends the 2-bit VC header field to 4-bits, adding the 2-bit VCX field as the two most-significant bits of the ECC byte. DPhyGenCtl supports the VCX field as follows:

- The VC command argument field can now have values from 0-15. This applies to the VC parameter in relevant RPC calls (e.g. SEND_MIPI_CMD, ADD_MIPI_CMD, etc.).
- The DataID command argument field to the “Custom Command” and “Custom Long Command” is now 10-bits (DataID[9:0]), where the four most-significant bits are the VC field.
- Automatic ECC calculation for component commands in the File Command script can use a new code (-3) to include a fourth byte in the calculation. The fourth byte contains the VCX field (see section 5.10 for more information).

5.6.7 Special Command Types

5.6.7.1 Video-mode Commands
Video-mode commands are one of many possible video-mode command types that cause the application to build and send one or more video frames, which are sourced by user-provided image files (or special test pattern names). A video-mode frame consists of multiple packets and has specific structure defined by the current standard (CSI or DSI). Timing between frame structure elements is controlled by the current frame timing settings. Video-mode commands are described further in section 5.7.
5.6.7.2 Display Stream Compression (DSC) Video

DSI version 1.2 defines a new packet type: Compressed Pixel Stream. This packet type allows a compressed stream constructed according to the VESA Display Stream Compression (DSC) standard to be sent. DPhyGenCtl provides a separate purchase option for extensive support for DSC-related functions, which includes the following:

- Automated building of DSC 1.1 or 1.2 streams from image files and test patterns for video-mode and Write Memory commands that use the compressed video format.
- Automated extraction of PPS data for DSC files, or automated construction of PPS data for image files when sending the Picture Parameter Set command.
- Support for the DPX and DSC file types in compression commands
- User decoding/encoding of DSC files to/from image files
- Image viewing of DSC files
- Write Memory partitioning and video-mode packetization option to send either one chunk per packet or possibly multiple chunks per packet.

Compressed video is described further in section 5.7.5.

5.6.7.3 Macros

A macro is a user-defined sequence of MIPI commands, sent as a single unit. Macros can be defined in the GUI, in a script file, or via a user program using RPC, then named and sent like any other command. Macro commands are described further in section 5.8.

5.6.7.4 Phy Commands

Phy commands are special low-level or LP signaling commands. Some are defined by the DPhy specification such as BTA, ULPS, skew calibration sequence, clock on/off commands, etc. Other commands are not part of the DPhy specification but have been adopted from CPhy for bus testing such as TGR and PRBS sequences. Phy Commands are describe further in section 5.9.

5.6.7.5 File Command

The File Command is general-purpose, low-level command that uses a text file as input to define arbitrary LP and HS DPhy signaling sequences. Using special file command syntax, low-level LP and HS lane states and higher-level packet data bytes can be intermingled as desired to create user test sequences and error packets. Command syntax also supports useful features such as automatic ECC and CRC generation, HS burst signaling generation (e.g. HS entry/exit and sync), and packet data demultiplexing. The file command is described further in section 5.10.

---

7 Without the DSC option, DPhyGenCtl does not provide these functions but still supports sending compressed video using binary files.
5.6.7.6 **PG File Command**
The PG File command provides a method to send compiled programs that have been previously saved to a new binary file type called a PG file. This allows long compile-time programs to be built only once, saved to a PG file, then sent very quickly subsequently. This process is described further in section 5.11.

5.6.7.7 **Script Commands**
Script commands are RPC (remote procedure call) commands contained in a user-defined text file. RPC commands provide the function of almost every action provided in the GUI, such as command and macro definition, command button management, frame timing, DPhy timing, instrument configuration, sending of commands, etc.

Script files are sent using the “RPC Script” command, specifying or browsing for a file name in the “File Name” argument field. Please see section 6 and more generally the document “DPhyGenCtlRPC.pdf” for more information.

One new feature to DPhyGenCtl is the ability to embed script commands directly in the filename text. If the filename begins with a comment string “//” or script command symbol “#”, then the filename string is treated directly as a script. For multi-line scripts, editing can be achieved using the Script Edit Dialog, which is brought up instead of a file browsing dialog when the ellipsis button “…” is clicked next to the command filename (assuming the filename starts with a “//” or “#”).

The Script Edit Dialog is simply a dialog with a text box containing the script that the user can type in. A Clear button is provided to clear the text box. Otherwise, the user can edit the script and then click OK to accept the changes or Cancel to discard any changes.

5.6.7.8 **Variable Argument Commands**
Certain commands allow the user to specify a variable number of parameters through an argument text box named “Params[]”, specifically the following commands:

10. Generic Short or Long Write Command (DSI)
11. Generic Read Request (DSI)
12. Generic Short or Long Read Response (DSI)
13. Custom DCS Short Write (DSI)
14. Custom DCS Long Write (DSI)
15. Custom DCS Read Request (DSI)
16. DCS Short or Long Read Response (DSI)
17. Custom Short or Long Command (DSI, CSI)

The differences between these commands are minimal. The “Custom Short or Long Command” is the most general, allowing the user to specify the full DataID byte (which
includes the virtual channel field). The other commands provide only a VC argument field, with the DataType implicit to the command type. The DCS commands also allow the user to specify the DCS command byte. All allow a variable number of arbitrary arguments, computing the ECC, packet length (for long packets), and CRC (for long packets).

For command types that have “Short or Long” in the name, the actual packet constructed may have either long or short packet formatting, depending on the number of values parsed from the Params[] argument string. For non-DCS packet types, if Params[] contains 0, 1, or 2 bytes, then short packets are constructed. For DCS packet types, if Params[] contains 0 or 1 byte, then short packets are constructed (starting with the DCSCmd byte). Otherwise, long packets are constructed and additional read-only fields for the packet length and CRC appear.

The Params[] argument string consists of byte values separated by white-space or commas. As with other argument fields, values are assumed to be decimal unless appended with ‘h’ (hexadecimal) or ‘b’ (binary). For example, “30 41h 10101b” is a legal parameter string.

5.6.7.9 Long Data File Format Commands

Certain non-video packet types (e.g. Long Pkt (Non-Image Data), Generic Long Write, DCS Long Write, etc) have a “File Name” argument. For these commands, with the exception of the DCS Write Memory commands, the file may be treated as a simple binary file or as an ASCII file with specific syntax. In either case, the file data is always sent as the payload of a single long packet.

A file is considered an ASCII file if it contains only legal ASCII characters and contains the line “# ASCII”. ASCII files are imported using the following rules:

- Comment lines that start with “//” as well as blank lines can occur anywhere in the file.
- Data lines always must occur after the “# ASCII” marker line
- Data lines consist of one or more data bytes in hex format

For example, the following text is legal in an ASCII file:

```
// Example ASCII file syntax
# ASCII
20 5B 30 5D 20 3D 20 30 78 31
35 0D 0A 64 61 74 61 20 5B 31
5D 20 3D 20 30 78 31 31 0D 0A
```

For Write Memory commands, the file is treated as a binary or ASCII file only if it does not have a recognized image file extension (i.e. “.bmp”, “.jpg”). Otherwise, the file is imported and processed as an image file. In addition, the Write Memory commands have special partitioning support in DPhyGenCtl, where a sequence of Write Memory
commands is sent to implement the user request of a single Write Memory command. This additional support is offered because the Write Memory commands are often used to send video data to a frame buffer on the DUT. Please see the next section for more details about this support.

5.6.7.10 DCS Write Memory Commands

For Write Memory Start and Write Memory Continue commands, the “Write Len” argument specifies the number of bytes to send and the “File Offset” argument specifies the starting byte offset in the file or frame buffer\(^8\).

Note that these parameters apply after the file has been imported, which for image files may include decoding, rescaling, and conversion to the output video format and for DSC files includes extracting the chunk data. Thus, the parameter name “File Offset” might be misleading when using image files (in this case, the parameter might be better called “Image Data Offset”). No processing occurs when using binary files.

For example, to send line 10 of an image to a 640 x 480 RGB121212 display:

- Compute the line length as \(3 \times 12 \times 640 / 8 = 2880\) bytes
- Set Write Len = 2880
- Set File Offset = 10 \times 2880 = 28800

DPhyGenCtl has additional features that enhance the behavior of sending Write Memory commands:

- **Image File Decoding** – If a file has extension “.bmp” or “.jpg” the image file is first imported before it is sent. When imported, an image file may first be rescaled if necessary to the output frame dimensions as described by the HActive and VActive fields of the current Frame Timing configuration. This only occurs if the option “Allow Image Rescaling” is enabled. Then, the image is converted to the format as specified in the “Image Decode Format” drop-down control.

- **Block Partitioning** – A single Write Memory command can be partitioned into a sequence of Write Memory commands. The user configures this behavior via “Configure Write Memory Commands…” in the Options menu.

Figure 7 shows the Write Memory Configuration dialog, which is brought up via the “Configure Write Memory Commands…” in the Options menu.

---

\(^8\) Note: “Write Len” can be set to 0 to send the contents of the entire file
The dialog has the following controls:

**Enable Partitioning CheckBox** – when checked, partitioning is enabled and Write Memory commands are decomposed into a sequence of Write Memory commands according to the parameters in the dialog. Otherwise, “Write Len” argument values greater than 64 KB (the maximum single packet payload length) return an error.

**Quantize Packets to Multiple of Line Length** – when checked, partition lengths are set to the greatest multiple of the image line length less than the “Partition Length” setting. The image line length is computed in one of two ways, depending on whether “Allow Image Rescaling” is enabled. If rescaling is enabled, then the image line length is computed using the HActive setting in the Frame Timing configuration and the pixel format for the selected “Image Decode Format”. Otherwise, the image line length is computed using the input line width times the bytes per pixel for the format specified in “Image Decode Format”.

**Partition Length** – indicates the maximum length to use for component Write Memory commands in the sequence.

**LP11 Partition Interval** – indicates the amount of time to spend in LP11 between each component Write Memory command in the sequence. Specify zero for no delay between component commands. In this case, if the “Send single packet per HS burst” option is not set and the command is sent in HSDT mode, the entire command sequence will be sent in a single HS burst (otherwise, each component Write Memory command will be sent in its own burst).
Image Decode Format – specifies the destination image format to decode files that have an extension of “.bmp” or “.jpg” (or also “.dpx” for compressed video).

RGB Bit Order – specifies the bit ordering of pixel data when RGB images are sent in command mode. The Annex A in the DCS specification indicates image data is to be sent using a different bit ordering than video-mode data for some RGB formats (in particular 5-6-5, 10-10-10, and 12-12-12). Because previous versions of DPhyGenCtl send RGB image data with the same bit ordering as video-mode frames, the user is given the option here to select legacy bit-ordering (same as video-mode) or DCS Annex A bit-ordering.

5.6.7.10.1 Sending Compressed Video
If the “Image Decode Format” is set to “DSC Compressed” then data sent with the Write Memory command is assumed to be compressed video. Behavior is different depending on whether the DSC license option is installed:

With DSC License:
- Files with “.dsc” and “.dpx” extensions may be used
- Image files and test patterns can be used. If necessary (and enabled), the image is rescaled to the current output frame dimensions (as specified in the current Frame Timing configuration). Then, the image is compressed using the current DSC configuration settings.
- For image and DSC files, partitioning occurs (if enabled), ignoring the partition length. The partition length is set to the chunk size in the compressed stream or a multiple of the chunk size, based on the “Send One Chunk Per Packet” setting in the DSC configuration.
- For binary files, partitioning occurs (if enabled), according to the Partition Length setting. In this case, the user should set the Partition Length to the length of one or more chunks per the DSI standard.

Without DSC License:
- Only binary files may be used. Behavior is same as for binary files with license.

5.6.7.10.2 Partition Example 1
Consider a Write Memory Start command issued with the following arguments:

File Name = test.bmp
File Offset = 0
Write Len = 100000

and Write Memory configuration settings:

Enable Partitioning = true
Quantize Packets to Multiple of Line Length = false
Partition Length = 30000
LP11 Partition Interval = 1.5 us
Image Decode Format = Packed 24-bit RGB 8-8-8

Then, DPhyGenCtl sends the following packet sequence:

1) Write Memory Start with RGB888 image data bytes 0-29999
2) LP11 for 1.5 us
3) Write Memory Continue with RGB888 image data bytes 30000-59999
4) LP11 for 1.5 us
5) Write Memory Continue with RGB888 image data bytes 60000-89999
6) LP11 for 1.5 us
7) Write Memory Continue with RGB888 image data bytes 90000-99999
8) LP11 for 1.5 us

5.6.7.10.3 Partition Example 2
Consider a Write Memory Continue command issued with the following arguments:

File Name = test.bmp
File Offset = 0
Write Len = 60000

and Write Memory configuration settings:

Quantize Packets to Multiple of Line Length = true
Partition Length = 30000
LP11 Partition Interval = 0.0 us
Image Decode Format = Packed 24-bit RGB 8-8-8
HActive = 640 (frame timing dialog)

Then, DPhyGenCtl sends the following packet sequence:

1) Write Memory Continue with RGB888 image data bytes 0-28799
2) Write Memory Continue with RGB888 image data bytes 28800-57599
3) Write Memory Continue with RGB888 image data bytes 57600-59999

Note that the output image line length is 1920 bytes and that the first two partitions contain exactly 15 lines of image data because “Quantize packets to Multiple of Line Length” is set to true.

5.6.7.11 LP Delay
The “LP Delay” command is a low-level command that allows the user to assert a particular LP state on all data lanes of the DPhy bus for a specified period of time. This command is generally used in a macro sequence.

The “LP Delay” command has two arguments:
- **Delay (us)** – the length of time to hold the bus in the specified LP state. This value is floating point.
- **LPValue[9:0]** – value encoding the LP states for all four data lanes plus the clock lane as described in section 3.4.

Note that if the clock lane is in HS mode when the “LP Delay” command is sent, LPValue[9:8] controlling the clock lane LP state are ignored. Use the “Clock Off” command to first return the clock lane back to LP11 before sending the “LP Delay” if clock lane control is desired.

### 5.6.7.12 Delay To Pos

The “Delay To Pos” command is equivalent to “LP Delay” except that its Delay parameter is relative to a position in a macro called “Zero Pos”, defined by the user with the “Mark Zero Pos” command. This command is useful when defining video frames in macros, allowing the user to define relative times between packets (e.g. active video packets, line start, line end, etc). See the “LP Delay” command for a definition of command arguments.

### 5.6.7.13 Mark Zero Pos

The “Mark Zero Pos” command (no arguments) defines a “Zero Pos” location in a macro. Subsequent “Delay To Pos” commands use “Zero Pos” as a reference position/time in the macro to define the relative duration of a delay. Note that multiple “Mark Zero Pos” commands are allowed in the same macro.

### 5.6.7.14 Wait Ext Event

The “Wait Ext Event” command inserts an indefinitely looping “LP Delay” period in a macro stream, causing output to suspend in the specified LP state until an external event edge occurs.

### 5.6.7.15 Assert Trigger

The “Assert Trigger” command is equivalent to “LP Delay” except it has a third parameter (“Trig Cmd”) that specifies the specific trigger command to send, controlling the Trig Out signal of the DPhy Generator. The trigger command is implemented near the beginning of the “LP Delay” period, but exact timing depends on the output frequency and may vary relative to the period start with each trigger command.

Table 4 shows the trigger commands. Note that the trigger pulse width is defined in the Instrument Configuration dialog.

**Table 4 – Assert Trigger Commands**

<table>
<thead>
<tr>
<th>Trigger Command Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set Trig Out low</td>
</tr>
<tr>
<td>2</td>
<td>Set Trig Out high</td>
</tr>
<tr>
<td>3</td>
<td>Toggle Trig Out state</td>
</tr>
<tr>
<td>4</td>
<td>Pulse Trig Out</td>
</tr>
</tbody>
</table>
5.6.7.16 Cmd Insertion Point

The “Cmd Insertion Point” is equivalent to “LP Delay” except it additionally defines a location in the macro where another command can be inserted while the macro is looping. This feature is equivalent to command insertion during video-mode.

The first two parameters (Delay, LPValue[9:0]) are the same as for “LP Delay”. A third parameter, called Discard, is a flag that affects how the Delay period is affected by the length of the inserted command.

Table 5 – Cmd Insertion Point Discard Setting

<table>
<thead>
<tr>
<th>Discard Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The inserted command is truly inserted into the program stream. Thus, if the Delay setting is 10 us and the inserted command requires 20 us, the ending time of the LP delay period would be 30 us.</td>
</tr>
<tr>
<td>1</td>
<td>The inserted command consumes the LP delay period as needed. If the inserted command does not complete before the end of the delay period, then subsequent stream data is held off until the inserted command is complete. Thus, in the prior example, the ending time of the LP delay period would be 20 us.</td>
</tr>
</tbody>
</table>

Please refer to section 5.13.3 for further details of command insertion.

5.7 Video-mode Commands

5.7.1 Overview

When a user sends a video-mode command (e.g. DSI Pixel Stream commands, CSI RGB, CSI Raw, etc) DPhyGenCtl automatically builds a packet stream representing one or more video frames, having the appropriate timing and structure according to the DSI or CSI standard. The video sequence can be played once or looped continuously to provide ongoing real-time video for emulation of baseband DSI display streams or CSI camera streams.

All video-mode commands accept a “File Name” argument to specify an image reference containing the video frame data to send. To send a video sequence of more than one frame, “File Name” uses a special naming convention to allow DPhyGenCtl to derive the file names for subsequent frames in the sequence (see section 5.7.2).

Before sending a video-mode command, additional parameters of video-mode playback must be appropriately configured in the Frame Timing dialog (see section 5.7.3). These timing parameters, like other application settings, are saved and restored in an application configuration file when DPhyGenCtl is closed and restarted.

Once a video command has been defined and the timing configuration parameters have been set, sending the command initiates the sending of the video-mode stream. The

internals of how video frames are constructed is described in section 5.7.4. Once video frame packets have been built and downloaded to the DPhy Generator instrument, video begins playing on the DPhy bus.

If the “Loop Commands” option (Options menu) is checked, video frames are played and looped indefinitely, stopping only when the “Stop PG” button at the bottom of the main window is pressed. When the DPhyGenCtl stops a looping video sequence, the current frame is completed before exiting and returning to the LP11 quiescent state.

5.7.2 Video Command Definition

All video-mode commands have the four arguments:

1) File Name – source image file or test pattern name
2) VC – virtual channel
3) Frame Count – number of frames to send
4) Video Error – control word encoding a data bit error position in the frame

The VC and “Frame Count” arguments are self-explanatory. However, the “File Name” and “Video Error” fields are described further in the next sections.

5.7.2.1 File Name Syntax

The “File Name” argument to video-mode (and Write Memory) commands may reference many source types and structures:

- **Test Pattern**: special naming conventions are provided to allow simple test patterns to be constructed and used as the input image source for video-mode commands.
- **Image File**: an image file with extension BMP or JPG
- **DPX File**: an image file with extension DPX.\(^9\)
- **DSC File**: a compressed image file with extension DSC.\(^9\)
- **Binary File**: any file that doesn’t fall in the above categories is treated as a binary file. In this case, rescaling and format conversion are not supported and the file data is expected to be in the proper format for the video-mode command being sent. In particular, the file should have at least the number of bytes required by the current timing configuration and video format. That is, HActive * VActive * BytesPerPixel.\(^10\)

**File Command Script**: a frame generation script using File Command syntax. The File Command script language supports algorithmic test pattern generation, format conversion, image rescaling, file import, etc.

\(^9\) DSC and DPX files are only supported when using the DSC compressed video format.

\(^{10}\) The number of bytes per pixel for binary files when using the DSC compressed video format is derived from the configuration file in the current DSC configuration, which must have a BITS_PER_PIXEL assignment.
Note that while DPhyGenCtl does not support video file types directly (i.e. AVI, DivX, MPEG, MOV, WMV, MP4, etc), it is easy to use extracted image sequences from video files using various third-party extraction tools that are available. One recommended shareware tool is Advanced X Video Converter:

http://www.aoamedia.com/videoconverter.htm

This tool is inexpensive and very straightforward to use and image files extracted using this tool adhere to the required naming format for DPhyGenCtl images.

When “Frame Count” is greater than one, thus requiring an image sequence as input, the file name may either:

1. implicitly refer to an image sequence (using special multi-file sequence naming)
2. reference only one image (in which case it replicated for the entire sequence)

5.7.2.1.1 Multi-File Sequence Naming
To play a sequence of multiple frames, the video-mode “File Name” argument may reference the first frame of the sequence and have the following format:

“<name><index>.<ext>”

where <name> is an arbitrary file name, <index> is an integer and <ext> is the file extension. DPhyGenCtl derives the file names of subsequent frames automatically by incrementing <index>.

For example: if “c:\frame1.bmp” is specified as the file name and the frame count is set to four, DPhyGenCtl builds a video sequence from the files:

3. c:\frame1.bmp
4. c:\frame2.bmp
5. c:\frame3.bmp
6. c:\frame4.bmp

Multi-file Sequence Notes:

- All single image reference types can be used in multi-file sequence naming.
- If “File Name” is a video file, the first “Frame Count” frames are used from the file.
- If “File Name” does not have the multi-file naming syntax (or a test pattern name is used), the sequence is still built repeatedly using the single given “File Name” reference.
5.7.2.1.2 Stereoscopic File and Sequence Naming
Stereoscopic file and sequence naming can be accommodated with further conventions. If these conventions are not used, then standard naming conventions can be used to define a single-image stream from which left/right images are automatically created by extracting alternating pixels from each image in the sequence.

To provide stereoscopic images, the further convention is to append an ‘L’ and ‘R’ to the file name or file sequence and specify the left image file name in the command. Note this convention applies only to image files and binary files and not currently to video files.

For example, a stereoscopic video sequence can be specified with “File Name” set to “c:\frame1L.bmp” and uses the files:

7. c:\frame1L.bmp, c:\frame1R.bmp
8. c:\frame2L.bmp, c:\frame2R.bmp
9. c:\frame3L.bmp, c:\frame3R.bmp
10. c:\frame4L.bmp, c:\frame4R.bmp

5.7.2.1.3 Test Pattern Naming
Special file names can be used to generate test patterns rather than specifying an image file name. Simple solid color frames, basic ramps, and grids can be generated using special file name conventions.

In order to aid usage, press Ctl-t to bring up the Text Pattern Syntax dialog. Figure 8 shows this dialog which describes the naming convention used to generate different test patterns.
Figure 8 – Test Pattern Syntax Dialog

A single, solid color frame is generated with the syntax:

\[ \text{SOLID} \_ <R> \_ <G> \_ <B>. \]

For example, to generate a full-frame consisting of the single color with red = 100, green = 150, and blue = 200 (8-bit values), enter “solid_100_150_200” for the “File Name” argument of the video-mode or Write Memory command.

A horizontal, vertical, or diagonal ramp can be generated with the syntax:

\[ \text{RAMP} \_ <hvmask> \_ <rgbmask>. \]

The <hvmask> value, if present, can be 1 (vertical), 2 (horizontal) or 3 (diagonal). The <rgbmask> value, if present, specifies which color planes are active. For example, RAMP_3_4 specifies a diagonal ramp in red-only and RAMP_2_3 specifies a horizontal ramp in both green and blue.

A monochrome grid pattern can be generated with the syntax:

\[ \text{GRID} \_ <on_cnt> \_ <off_cnt> \_ <solid_line_cnt> \_ <var_line_cnt> \]

The grid pattern consists of two types of lines: solid lines and variable lines. Variable lines are defined by the user with <on_cnt> and <off_cnt>, basically defining the repeating pattern of “on” pixels followed by “off” pixels. Then the test pattern is formed by a repeating pattern of solid lines for <solid_line_cnt> followed by variable lines for <var_line_cnt>.

For example, <on_cnt> = 1 and <off_cnt> = 9 defines a variable line that has a single white pixel every 10 pixels. If <solid_line_cnt> = 1 and <var_line_cnt> = 9, then the naming syntax is GRID_1_9_1_9 and the pattern formed is a grid with single line thickness with 10 x 10 squares. GRID_5_15_5_15 defines a grid with 5-pixel line thickness with 20 x 20 squares.

Finally, the CTS Reference Pattern Colorbars can be generated using the test pattern name:

\[ \text{CTS\_COLORBARS} \]

This test pattern is described in the MIPI CTS for DPhy document in Appendix D.

5.7.2.2 Frame Generation Using File Command Script

New with DPhyGenCtl version 3.6 is the ability to use File Command scripts to generate video-mode or Write Memory data. In addition, scripts can be defined as an “Internal
File”, meaning script commands can be embedded directly in the File Name argument of the command (see section 6.3). Many features of File Command syntax are useful for image generation including the LOAD_FRAME command for importing image files, CONVERT for converting image buffers to different pixel formats, and RESCALE for resizing an image buffer. Also useful are looping and conditional execution constructs, user variables, and functions. Finally, system variables are also provided for command usage such as HActive and VActive frame timing settings, lane count, current command data type, etc.

As a simple example to try, the user can send a constant-pixel RGB888 frame with the current HActive and VActive dimensions as follows:

1. Define a new command by selecting the Packed Pixel Stream RGB888 packet type.
2. In the “File Name” argument, type a ‘#’ and click on the “…” button to open the Internal File editor.
3. Replace the ‘#’ with: “*(SYS_HACTIVE_SYS_VACTIVE) 10 100 200” (remove quotes)
4. Click “OK”
5. Send the command.

Example File Command scripts are provided with the DPhyGenCtl installation. A link is provided to these files in the link: Start->DPhyGenCtl->File Command Scripts. The subdirectory “Non File Command Payload Generation” contains scripts specifically for video commands.

For more information about the File Command please see section 5.10.

5.7.2.3 Video Error Syntax

The “Video Error” argument allows the user to encode a bit position in the video frame(s) to force a bit error in the frame data during output. The argument is encoded as follows:

- Video Error bits [31:16] indicates the error line in the image (ones-based)
- Video Error bits [15:0] indicates the error bit position in the line (zero-based)
- It is set to 0 for no error insertion.

For example, to cause a bit error in the most-significant bit of pixel 10 of line 10 in a CSI Raw 10 image, this corresponds to bit position 10 * 10 + 9 = 109 = 0x6D. Thus, set:

    Video Error = A006Dh.

5.7.2.4 Image Viewing Dialog

An image viewer is built into the application to view image files used in video and DSI Write Memory commands. The viewer can be invoked by pressing Alt-i, causing the image file (if present) of the current command to be displayed in a separate image
window. Note that if the image size is large, it is re-scaled to a reasonable viewing size. Press Return or click OK to close the image window.

Viewing also applies if “File Name” is a test pattern name and so is a convenient way to see that the test pattern name syntax is correct. Also, for video files, currently only the first frame is shown.

5.7.3 Frame Timing Dialog

The “Timing Cfg…” button in the main window brings up a dialog to set video-mode frame timing settings. These settings select video-mode protocol options and define active and blanking parameters of video-mode playback. Please note that this dialog does not configure DSI video frames sent via command-mode (i.e. using the Write Memory commands) except if an image file is specified and the “Allow Image Rescaling” option is enabled. In this case, the input image is rescaled according to HActive by VActive before sending.

Figure 9 shows the DSI layout of the Frame Timing dialog. Depending on the current MIPI protocol (DSI or CSI), certain fields have different names or are disabled. In particular, CSI:

- Has options “Use LS/LE”, “Frame Numbering”, and “Line Numbering”
- Disables front-porch and back-porch timings
- Disables 3D stream construction fields and “Top-field First” interlace option.

And, alternatively, DSI:

- Has options “Sync Mode”, and “Burst Mode”
- Enables front-porch and back-porch timings
- Enables 3D stream construction fields and “Top-field First” interlace option
5.7.3.1 Frame Timing Configurations

At the top-most part of the Frame Timing dialog is a configuration drop-down control along with two buttons, labeled ‘…’ and ‘Save’. These controls are used for named configuration management as follows:

**Configuration**: drop-down control showing pre-defined and user-defined configuration names. Selecting a configuration name fills in its definition in the remaining frame timing dialog controls.
Pre-defined configurations contain example settings for common frame dimensions. However, please be aware that these configurations may not work for all combinations of video formats and lane counts, because of legal timings depending significantly on these parameters.

... button to launch a List dialog to manage named frame timing configurations (i.e. rename, reset, reorder, delete, etc).

Save button to save the current control settings as a named frame timing configuration.

5.7.3.2 Frame Parameter Controls
Controls near the top part of the window specify horizontal and vertical blanking frame component dimensions as well as the active dimensions of the frame. Read-only H and V totals are automatically computed as field values are entered.

Note, for CSI, that the HSync blanking period must be long enough to account for all packet overhead in the line (i.e. SOT/EOT and packet headers). For DSI, each blanking period must be long enough to account for individual blanking segment overhead, with front porch blanking additionally accounting for active packet overhead.

If the blanking setting(s) are insufficient, an error message is displayed when a video command is sent. The message also estimates the additional number of pixels needed for HSync to make the video frame implementable, e.g.

“Error: HSync is too short to implement LP11 blanking (need approx. 17 more pixels)”.

5.7.3.3 Clock Timing Controls
Controls in the center-right of the window let the user specify the pixel clock timing in four different ways, via: line time duration, pixel clock frequency, frame rate, or HS bit rate. Entering a value in one of these four controls automatically updates the other three.

The HS Bit Rate text box sets/indicates the lane bit rate for the current timing configuration. This value is dependent on the current timing settings, the current packet type selection in the main window (indicating the video format) and the lane count. If the current packet type is not a video command, HS Bit Rate displays “N/A” and the text box is disabled. Otherwise, the text box is enabled, allowing the user to enter a bit rate. Note that if the Lane Count is subsequently changed, the HS Bit Rate changes along with it (keeping the line time, pixel clock, and frame rate constant).

5.7.3.4 CSI Frame Construction Controls
There are three frame construction options for CSI:

Use LS/LE: drop-down control selecting Line Start/Line End packet usage:
- Yes: Line Start and Line End packets are inserted into the video stream and bracket each active video packet.
- Page 42 -

No: Line Start and Line End packets are not inserted into the video stream.

**Frame Numbering:** drop-down control selecting Frame Numbering usage:
- **0:** the frame number parameter in the Frame Start and Frame End packets is set to zero.
- **1,2,3…:** the frame number parameter in the Frame Start and Frame End packets is set, starting with 1 and incrementing each frame.

Note that the frame number only increments for each unique frame in the sequence and repeats when looping. For example, if only a single-frame sequence is sent, the repeating frame always has frame number equal to ‘1’.

**Line Numbering:** drop-down control selecting Line Numbering usage:
- **0:** the line number parameter in the Line Start and Line End packets is set to zero.
- **1,2,3…:** the line number parameter in the Line Start and Line End packets is set, starting with 1 and incrementing each line.

### 5.7.3.5 DSI Frame Construction Controls

There are three frame construction options for DSI:

**Sync Mode:** drop-down control selecting the HSync Mode:
- **Events:** horizontal syncs in active lines of video frames are conveyed with only an HSync Start packet
- **Pulses:** horizontal syncs in active lines of video frames are conveyed with an HSync Start packet, followed by blanking time, and then an HSync End packet. Note this option is only available in Non-Burst mode.

**Burst Mode:** drop-down control selecting the burst mode:
- **Non-Burst:** non-burst mode assumes the DSI clock is just sufficient to transmit active lines with no extra bandwidth. When this option is selected, the HS Bit Rate control is made read-only in the frame dialog and automatically set according to frame timing settings.
- **Burst:** burst mode assumes the clock is set faster than necessary to transmit the video frame. Currently, the excess bandwidth associated with each line is treated as part of horizontal front-porch blanking.

**Top-Field-First (interlace fnts):** selecting this option causes the top-field (i.e. lines 1, 3, 5…) of the image to be sent before the bottom-field (i.e. lines 2,4,6…) when sending interlaced video. Otherwise, the bottom-field is sent before the top-field.
5.7.3.6 Common Frame Construction Controls

Common frame construction options for both CSI and DSI indicate the method to be used for blanking segment implementation:

**HSync Blanking:** this control specifies whether to implement the HSync blanking period via LP11 or an HS blanking packet. A third option is “Auto” which implements the blanking segments via LP11 unless it is too short in which case the segment is implemented with an HS blanking packet.

**HBPorch Blanking:** this control (disabled for CSI) specifies whether to implement the HBackPorch blanking period via LP11 or an HS blanking packet. A third option is “Auto” which implements the blanking segments via LP11 unless it is too short in which case the segment is implemented with an HS blanking packet.

**HFPorch Blanking:** this control (disabled for CSI) specifies whether to implement the HFrontPorch blanking period via LP11 or an HS blanking packet. A third option is “Auto” which implements the blanking segments via LP11 unless it is too short in which case the segment is implemented with an HS blanking packet.

**Vertical Blanking:** this control specifies whether to implement the blanking periods during Vertical blanking as LP11 or HS blanking packets. A third option is “Auto” which implements the blanking segments via LP11 unless it is too short in which case the segment is implemented with an HS blanking packet. Note that vertical blanking lines in DSI have one blanking period in “Event” mode and two blanking periods in “Pulse” mode (with the HSync End packet in between them).

**Dual-Interface Mode:** this control selects how video-mode frames are mapped to master/slave interfaces when operating in dual-instrument mode (i.e. two linked P344 instruments). This control is only enabled when a slave P344 is connected.

**Play Mode:** this control indicates whether the frame sequence should be played once or looped indefinitely. Earlier versions of software used the general “Loop Commands” option (Option menu) for this purpose but providing this separate looping control for video mode commands now offers more user control.

**Turn Clk On/Off During LP11 Blanking:** this checkbox specifies if the clock should be turned off at the beginning of LP11 blanking and back on again at the end of LP11 blanking.

**Advance Frame On External Event:** this checkbox specifies if each frame in a video sequence should loop individually and only advance to the next frame in the sequence when a rising edge is detected on the external event line of the instrument (GPI0 of the back-panel connector).

**Enable Skew Cal:** this checkbox indicates if a deskew burst sequence is to be sent before each frame in a video sequence. If checked, the corresponding textbox is
enabled for the user to enter the deskew burst duration (in UI). If UI is set to zero, the SkewCal setting in the current DPhy Timing Configuration is used.

**Enable Alt Cal:** this checkbox indicates if an alternate calibration sequence is to be sent before each frame in a video sequence. If checked, the corresponding textbox is enabled for the user to enter the alternate calibration sequence duration (in UI). If UI is set to zero, the AltCal setting in the current DPhy Timing Configuration is used.

### 5.7.3.7 Stereoscopic Frame Controls

The DSI 1.2 specification introduces a new option for sending stereoscopic frames based on the MIPI SDF specification. Stereoscopic frame construction is supported via controls in lower-right corner of the Frame Timing dialog and, for the most part, correspond directly to parameters fields of the SDF specification.

**Enable 3D:** when checked, this checkbox enables 3D stereoscopic video mode, and enables the remaining stereoscopic configuration controls. As according to the SDF specification, when 3D mode is enabled, the VSync Start packet is sent with a parameter byte that indicates the format of the 3D frame.

**Stream 3D Mode:** this drop-down control selects whether video-mode frames should be considered to be in portrait or landscape mode.

**Display Orientation:** this drop-down control selects whether the display is operating in portrait or landscape mode.

**3D L/R Order:** this drop-down control selects whether data is sent left-eye first or right-eye first.

**3D Format:** this drop-down control determines how left and right images are to be interleaved (pixel, line, or frame).

**3D VSync:** this checkbox determines whether a second VSync is sent between left and right images when 3D Format is set to Frame mode.

**Inter Frame VAct:** the text box accepts an integer value that determines how many lines should be sent between left and right images when 3D Format is set to Frame mode and 3D VSync is not checked.

### 5.7.4 Video Frame Construction Details

In contrast to relatively simple non-video-mode commands, video-mode commands define a complicated program stream of LP signaling and HS packets.

In CSI, a frame consists of the following:

- (VSync – 1) blanking lines
- First active line with Frame Start packet
- (VActive – 1) remaining active lines
- Blanking line with Frame End packet

All lines are of equal length in time; thus the lines with Frame Start and Frame End have shorter real horizontal blanking to account for the timing difference.

In DSI, a frame consists of the following:

- Blanking line with VSync Start packet
- (VSync – 1) blanking lines
- **Pulse Mode**: Blanking line with VSync End packet
- **Event Mode**: Blanking line with normal HSync Start packet
- (VBPorch – 1) blanking lines
- VActive active lines
- VFPorch blanking lines

A blanking segment can be implemented by HS blanking packet or a round-trip transition to LP11 for the required duration. Blanking segments set to “Auto” that are long enough to incur the overhead of the round-trip transition to LP11 use this method. Otherwise, the interval is implemented with a blanking packet. Of course, blanking packets also have overhead, and so segments must be at least long enough to accommodate the minimum length blanking packet.

While the desired timing characteristics of a video line are defined in the frame timing dialog, actual timings may slightly differ. This is because of the complexity of constructing arbitrary packet timing given internal restrictions for storing and playing LP states and HS bits in the instrument. In particular, all LP and HS periods are required to have periods that are a multiple of 2*UI and minor quantization of blanking segments may result.

### 5.7.4.1 Stereoscopic Frame Construction

The 3D stereoscopic standard impacts only the payload content of video-mode frames. Thus, the timing, dimensions, and structure of 3D frames are identical to non-3D frames. Regardless of 3D parameter settings, output frames always have dimension HActive by VActive. Input images are always rescaled if necessary during output frame construction.

Video-mode commands sent when stereoscopic video is enabled (i.e. Enable 3D checked) cause 3D frames to be constructed and sent. If the “File Name” argument references a single image or image sequence (see section 5.7.2.1), then each single image is used to build a pseudo-stereoscopic image pair by extracting alternating left/right pixels, rescaling if necessary, and then building the composite output image based on the SDF specification.
If the “File Name” argument references a true stereoscopic image or image sequence, then each image pair is imported, rescaled if necessary, and then used to build the composite output image.

Note that in the case where 3D Format is set to Frame and 3DVSync is checked, 2 * “Frame Count” images are sent in the output.

5.7.4.2 Command Insertion

Note that video frames are automatically built with a command insertion point in the first vertical blanking line. Command insertion is a special mode that allows most commands to be inserted into the program stream while the program is looping. This function is also available for the user during macro looping using the “Cmd Insertion Point” command. Please see section 5.13.3 for more information.

5.7.4.3 Video Memory Requirements

Memory requirements for the storage of video sequences in the DPhy Generator cannot be exactly described, due to the complexity of encoding, packing, and outputting the program stream as well as numerous dependencies such as number of lanes, video format, frame timing, and DPhy bus timing. However, in general, a reasonable upper bound can be given, based on HS bit packing in the instrument’s memory.

Basically, the packing efficiency of HS bits in memory is 75%, regardless of the number of lanes. Since the amount of memory in the DPhy Generator is 2 GB, this means a maximum of 1.5 GB of memory is available for video data. Thus:

\[
\text{Max Frames} = \frac{1.5 \text{ GB}}{(\text{HActive} \times \text{VActive} \times \text{BytesPerPixel})}
\]

A more accurate way to determine how many frames fit into memory give specific frame timing settings is to send a small sequence consisting of, say, 10 or 20 frames. Once running, the status readout indicates how much memory of the PG is used, as a percent of the total available.

Note that, currently, the DPhyGenCtl application does not manage host memory with great efficiency and cannot generally achieve the maximum frame count supported by the DPhy Generator (an out-of-memory error occurs when building the sequence). If this is a concern, please contact The Moving Pixel Company for more information. To improve the maximum frame sequence count, please ensure your host computer has a 64-bit processor, with at least 8 GB of memory, and a large page-file configuration.

5.7.5 DSC Compression

Extensive Display Stream Compression (DSC) support is provided with the DSC License option (please contact the Moving Pixel Company for licensing information). Without the licensing option, “Compressed Pixel Stream” and “Picture Parameter Set” commands can still be sent, but only accept binary file input for their “File Name” parameter. This section documents the additional features supported with the DSC License.
The DSC encoder supported by DPhyGenCtl is based on the DSC 1.2 codec provided by the VESA standard. The VESA codec supports many configuration options generally provided by two configuration files: one for more general encoding parameters and one for specific rate-control parameters.

For general encoding parameters, DPhyGenCtl provides GUI controls in the DSC Configuration dialog, eliminating the use of a general encoding configuration file. For rate-control parameters, DPhyGenCtl still uses the same rate-control configuration file as the reference VESA codec. For convenience, default rate-control configuration files are copied to the application directory during installation and can be referenced by the user in the DSC configuration dialog.

### 5.7.5.1 DSC Configuration Dialog

The DSC Configuration dialog (see Figure 10) sets all parameters related to DSC V1.2 encoding, displayed using the “Configure DSC” menu item (Options menu). As with other configurations (frame timing and DPhy timing), DSC configurations can be specified and saved, allowing for easy selection in the future.

Four controls at the top of the DSC Configuration dialog relate to naming and managing pre-defined configurations:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Drop-down control that selects a pre-defined, named configuration. When selected the parameters of the configuration fill in the other dialog controls.</td>
</tr>
<tr>
<td>…</td>
<td>Button next to the Configuration drop-down control to bring up a List dialog to order, rename, and delete named configurations.</td>
</tr>
<tr>
<td>Save</td>
<td>Button to save the current control settings to a named configuration. A name dialog is provided for the user to enter in a configuration name. If the name exists, the user is asked whether it is okay to overwrite the existing configuration.</td>
</tr>
<tr>
<td>Update…</td>
<td>Button to update the default named configurations from DSC 1.1 to DSC 1.2. This button is enabled only when default named configurations from prior versions are detected in the named configuration list. These names have the form “&lt;x&gt;bpc_&lt;y&gt;bpp” where &lt;x&gt; and &lt;y&gt; are specific integers in the range of 8-15. Clicking this button deletes these qualifying configurations and adds the new DSC 1.2 default configurations to the list. Other user configurations in the list are not affected but should be individually reviewed and manually updated if necessary.</td>
</tr>
</tbody>
</table>

Controls relating to an individual DSC configuration are as follows:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config File</td>
<td>Text box containing the file name of the DSC configuration</td>
</tr>
</tbody>
</table>
A file containing rate-control parameters. The syntax of this file is beyond the scope of this document (please see the DSC V1.2 standard documentation). Standard recommended rate-control configuration files are provided in the application directory and are referenced in the default named configurations.

- **Browse…** Button to bring up a file dialog to select a configuration file.

- **Slice Width** Text box to set the slice width. Set to 0 for the entire picture width.

- **Slice Height** Text box to set the slice height. Set to 0 to use the entire picture height.

- **DSC Ver. 1.2** Check box to indicate DSC version 1.2 encoding is to be used. If unchecked, DSC version 1.1 encoding is used, preventing the use of the Native 4:2:2, Native 4:2:0, and 14/16 BPC encoding support.

- **Use YUV Input** Check box to indicate that YUV image encoding is to be used. If unchecked, RGB image encoding is used. Note that “Use YUV Input” is automatically selected and the control is disabled if Simple 4:2:2, Native 4:2:2, or Native 4:2:0 sampling is selected (required by the DSC codec).

- **Use Rec 709 Color Space** Check box to indicate the color space conversion standard to use when converting between RGB and YUV color spaces. If checked, Rec. 709 color space conversion is used. Otherwise, Rec. 601 color space conversion is used.

- **Use Block Prediction** Check box to enable block prediction during DSC encoding.

- **Send One Chunk Per Packet** Check box selecting how chunk data is to be sent, both for Write Memory commands and video-mode commands. If checked, one chunk will be sent per packet. Otherwise, one or more chunks representing an image line will be sent in a single packet.

- **Native 4:4:4** Option box that selects 4:4:4 sampling of RGB or YUV color planes.

- **Simple 4:2:2** Option box that selects “simple 4:2:2” sampling of YUV color planes. In DSC, this mode instructs the generator to compress and send a YUV 4:4:4 image. A flag in PPS tells the receiver to subsample the received image to YUV 4:2:2.

- **Native 4:2:2** Option box that selects YUV 4:2:2 sampling.

- **Native 4:2:0** Option box that selects YUV 4:2:0 sampling.
5.7.5.2 Sending Compressed Frames in Video Mode

The “Compressed Pixel Stream” packet type is used to send one or more frames of compressed video. This command is very similar to other video-mode packet types, accepting the same arguments and implementing the frame timing as configured by user settings. The biggest difference is that image frames are first compressed (if not already compressed) using the current DSC configuration settings before the output video-mode frame is built.

Notes:

- In addition to the standard image, video, test pattern, and binary file types, the “File Name” argument has been extended to support DSC and DPX file types for this command. If a DSC file is provided, chunk data is sent directly as “Compressed Pixel Stream” packet payload. If a DPX file is provided, it is first compressed (like other non-binary file types) before used as packet payload.11

- Like other video-mode packet types, setting Frame Count greater than one causes a multi-frame sequence to be sent. Multi-file naming syntax can be used to specify the sequence of source image files to use.

- The “Video Error” parameter also is supported, with its value still encoding the line and error bit location. Note that the bit location indicates the error bit in the compressed source data and so can only affect payload data (not the packet header or CRC). This applies regardless of how many packets are used to send a line (i.e. independent of the “Send One Chunk Per Packet” setting).

---

11 Note that the DPX file type does not support automatic rescaling even if “Allow Image Rescaling” is enabled. Thus, the file must already have the correct output frame dimensions.
The option “Send PPS with compressed video” (Options menu) can be used to automatically send a Picture Parameter Set packet using the current DSC configuration settings before a video-mode packet.

5.7.5.3 Sending Compressed Frames in Command Mode

As with uncompressed images, DSC compressed video frames can be sent using the DCS Write Memory commands. This is achieved by selecting the “DSC Compressed” option for “Image Decode Format” in the Write Memory Configuration dialog and sending a Write Memory command.

Command arguments and behavior are the same, with the following extensions and clarifications:

- In addition to the standard image, test pattern, and binary file types, the “File Name” argument has been extended to support DSC and DPX file types for this command. If a DSC file is provided, chunk data is sent directly as Write Memory packet payload. If a DPX file is provided, it is first compressed (like other non-binary file types) before used as packet payload.
- The “Partition Length” and “Quantize Packets to Multiple of Line Length” settings in the Write Memory configuration are ignored. The payload length is always either one chunk or one line’s chunk data, based on the setting of the DSC configuration option “Send One Chunk Per Packet”.

Please see the more detailed description of operation in section 5.6.7.10.1.

5.7.5.4 Sending PPS Information

The Picture Parameter Set command conveys DSC compression information to the DUT in advance of sending compressed video packets. Without the DSC license option, only binary files can be sent with this command.

With the DSC license option, the user can also specify one of the following as the “File Name” argument:

- DSC compressed file name. In this case, the PPS structure in the file is sent as payload for the command.
- Any valid image or test pattern file name. In this case, a PPS structure is built using the current DSC configuration settings and active frame dimensions in the current frame timing configuration.

5.7.5.5 Compressing/Uncompressing Image Files

With the DSC license option, two keyboard functions are enabled in the main GUI window:

- **Control - C**: Compress the file or test pattern associated with the current “File Name” and output to a DSC file. The user is prompted for an output file name. If “Allow Image Rescaling” is enabled, the input image is first rescaled to the active frame dimensions in the current frame timing configuration.
• **Control - U**: Uncompress the DSC file in the current “File Name” field and output to an image file. The user is prompted for an output file name, which can have any common image extension (e.g. BMP, JPG, DPX).

### 5.7.5.6 Viewing DSC Images

With the DSC license option, the image viewing keyboard function is extended to view DSC and DPX files. Simply press **Control – I** to view the file when entered into the “File Name” field of the current command.

### 5.8 Macros

A macro is a sequence of MIPI commands, grouped and named as a single, new command. Once defined, they can be assigned to command buttons and sent to the DPhy Generator like any other command. When viewing and creating macros, controls in the Macro tab of the main window is used. These controls displays the component commands of the macro and allows basic macro editing (see Figure 11 below).

#### 5.8.1 Defining a New Macro

To define a new macro, click on the “Start Macro” button at the bottom right of the Macro tab pane. This button changes its caption to “End Macro” and activates the Macro Cmds list-box with no component commands initially present. In this editing mode (called macro mode), commands that are sent either via a command button, via the Send button at the top of the main window, or via an RPC programmatic command are entered into the macro instead of immediately sent to the DPhy Generator.

Note that in macro mode, the Send button label changes to “Insert” to indicate commands are to be inserted into the macro definition. If the Shift key is held down, the button label changes to “Replace” to indicate commands are to replace the current command in the macro definition.

Figure 11 shows an example of a macro in edit mode. Commands are added to the macro at the location highlighted in the macro pane. When added, a dialog appears for the user to name the component command of the macro. The user can scroll and select a command (or the blank line at the end of the command list) to mark the next command insertion/replacement location. Selecting a command also displays its arguments for viewing and modification.

---

12 Note: if the current Cmd Name is a macro then the list-box will be initialized with the macro’s component commands. If these commands are unwanted, the Clear All button can be used to delete them.

13 Note: the component command name dialog can be disabled by checking the GUI Option “Don’t ask for component command names during macro definition” (Options->Set GUI Options…). Component commands can still be renamed after insertion using the “Rename” command button.
Figure 11 – Macro Editing

Six buttons are available in the macro pane to manipulate the component commands of a macro.

- **Clear All** removes all the component commands in the macro.
- **Delete** removes the selected component command from the macro.
- **Rename** brings up a dialog to rename the selected component command.
- **Up** moves the selected component command up within the command sequence.
- **Down** moves the selected command down within the command sequence.
- **LS/LE** adds a “Loop Start” and “Loop End” command pair to the macro (which can then be positioned as desired using Up/Down). Before adding, a loop count dialog appears for the user to enter a loop count (0 for infinite).
When macro definition is complete, the user clicks on the “End Macro” button, bringing up a dialog to name the macro, save it, and exit macro mode (see Figure 12). Alternatively, the user may click Cancel to return to macro editing or “Discard Edits” to exit macro made, discarding changes entirely.

![Name Macro Dialog](image)

**Figure 12 – Name Macro Dialog**

As with command definition, if the user specifies the same name when saving a macro, the user is asked for permission to replace the existing macro definition.

### 5.8.2 Editing an Existing Macro

To edit an existing macro, the user has two options. If the macro is assigned to a command button, the user may right-click on it and select “Edit Current Command…” Alternatively, the user can select it in the command combo-box at the top of the main window then click on the “Start Macro” button. The macro can then be edited as normal and saved by clicking on the “End Macro” button. The name field is filled in with the original macro name and the user can click OK and confirm overwriting the existing macro.

### 5.8.3 Copying a Macro

To copy a macro, simply load a macro for editing, click on the “End Macro” button, and change the original name to a new name when saving.

### 5.8.4 Inserting a Component Command

To insert a new component command into a macro, perform the following (once in macro editing mode):

1. Click on a component command in the macro to set the insertion location
2. Send a command to insert it into the macro using any normal method, i.e.
   a. Select a Cmd Name and click the ‘Send’ button
   b. Select a Pkt Type, fill in arguments, and click the ‘Send’ button
   c. Click on a Cmd button
5.8.5 Replacing a Component Command
To replace an existing component command in a macro, perform the following (once in macro editing mode):

1. Click on a component command in the macro to select the command to replace
2. Send a command to replace it into the macro using any normal method while holding down the Shift key:
3. Select a Cmd Name and click the ‘Send’ button
4. Select a Pkt Type, fill in arguments, and click the ‘Send’ button
5. Click on a Cmd button

5.8.6 Editing a Component Command
To edit and replace a component command in a macro, perform the following (once in macro editing mode):

1. Click on a component command in the macro to retrieve its argument settings.
2. Change the argument settings as desired.
3. Click the ‘Send’ button while holding down the Shift key to replace the modified command into the macro.

5.8.7 Allowed Component Commands
The intent of a macro is to output a MIPI command sequence in real-time on the bus. Allowed macro component commands include all standard or custom MIPI packet types (LPDT or HS) accessible via the PktType drop-down control, as well as all Phy commands and Miscellaneous commands except for the “RPC Script” command.

In addition, the following notes apply to macro behavior:

- Component commands with BTA enabled are allowed in macros and behave as expected. The PG waits for a return BTA before continuing with the remaining component commands in the macro.
- Write Memory Start and Write Memory Continue commands are fully supported in macros, including image file decoding and command partitioning to support large “Write Len” counts.
- Macros cannot contain other macros; that is, macro nesting is not allowed. However, macros can nonetheless be added to other macros, in which case the component commands of the macro being added are themselves duplicated and added to the macro being edited.
- Video-mode commands can now be added to macros. Please see the next section for more information.
When a macro is built using an RPC program or script, allowed macro component commands are any command that can be sent via the following RPC commands:

- `SEND_MIPI_CMD`
- `ADD_MIPI_CMD`
- `SEND_IMPAIRED_MIPI_CMD`

In addition, a new feature supported by macros is the ability to contain certain non-MIPI configuration commands, allowing on-the-fly application reconfiguration (but not hardware reconfiguration!) for subsequent commands in the macro. For example, certain frame timing or DPhy timing parameters can be changed between two frames defined in the macro.

Generally, the following classes of non-MIPI RPC commands are allowed in macros:

- Frame buffer load and deallocation
- WriteMemory configuration
- DPhy Configuration
- Frame Timing configuration (except for frequency-related settings)
- DSC configuration
- Option setting that applies to program construction
- Bayer encoding type

For more details, please refer to the document DPhyGenCtlRPCCommands.pdf, which indicates which configuration RPC commands are allowed in macros (Note 9).

5.8.8 Video-Mode Commands In Macros

Video-mode command behavior in macros is determined by the setting of the option “Enable Video Mode In Macros” (Options menu). This section describes the two behaviors.

5.8.8.1 “Enable Video Mode In Macros” Enabled

If the option “Enable Video Mode In Macros” is enabled, a video-mode command in a macro causes a full video frame to be sent using the current frame timing configuration. However, note that when video-mode frames are played in macros, the clock rate used is the HS Bit Rate setting for the macro, not the configured HS Bit Rate in the frame timing configuration. If accurate frame timing is required, the user must set the HS Bit Rate in the main window to the same as the HS Bit Rate in the frame timing dialog when sending the macro.

5.8.8.2 “Enable Video Mode In Macros” Not Enabled

If the option “Enable Video Mode In Macros” is not enabled, only a single video data packet is played in the macro. In this case:

- The entire contents of the given file are put in the video packet (which, to be MIPI legal, must be less than 64 Kbytes)
• The “Frame Count” parameter is ignored
• The file argument is assumed to reference a binary file. That is, BMP file decoding is not supported.

Note that one additional variation is supported for video commands, though in general, it is accessible only through RPC (either via script or user program). This variation allows the video command to reference an internal frame buffer, previously loaded with a LOAD_FRAME RPC command. In this case, the filename used to reference the frame buffer is USERFRAME<n> where n is 0 through 3 and the two video command arguments refer to a byte offset and byte length in the frame buffer data.

5.8.9 Looping In Macros
The “Start Loop” and “End Loop” commands are used in macros to provide an easy way to duplicate a group of commands. Simply bracket the command group with the loop commands, for example

...  
Start Loop  
Cmd0  
Cmd1  
Cmd2  
...  
End Loop  
...

With the exception of infinite looping, this construct does not implement true looping and thus does not save any memory or construction time. But it is a useful convenience, especially for video frame construction, where a command sequence that implements one video line can be looped multiple times.

The “Start Loop” command has one argument, “Loop Count”, which indicates the number of times to loop the command group between start and end. A value of 0 indicates infinite looping, which causes the macro program to be constructed and sent as described in the next paragraph.

Commands that precede the infinite Start Loop are output normally and can be considered like an initialization sequence. Commands contained in the infinite loop are treated like a normal looping macro, outputting indefinitely until the “Stop PG” button is pressed. Note that commands that follow the infinite loop are discarded and never sent.

Generally, nesting of loops is not allowed, though multiple loops can occur serially within a macro. One exception is that non-infinite loops can occur within an infinite loop.
Note that there are pitfalls with using looping in macros. In particular, be aware that large loop counts can easily cause out-of-memory errors and so should be used with care (infinite loops do not consume additional memory). Also, loop sequences must be constructed carefully such that discontinuities do not occur at loop boundaries. It is important to ensure that clock state and bus state have legal transitions at loop boundaries. For example, looping on a single CLOCK_ON command will result in an illegal MIPI sequence, since the clock is never turned off before looping.

5.8.10 HS Component Command Behavior

When macros are parsed by DPhyGenCtl, the application can group consecutive HS component commands (that don’t have BTA enabled) into a single HS burst. Whether consecutive HS commands are sent in a single burst or sent individually in their own burst is determined by the setting of the “Send Single Pkt Per HS Burst” option (Options menu).

For mixed burst behavior, the user can disable this option, which will by default group consecutive HS commands into a single burst. Then, for those HS commands to be sent in their own burst, the user can the user can put “LP Delay” commands between them.

5.8.11 Additional Notes on Macro Behavior

Below lists some final miscellaneous notes on DPhyGenCtl behavior when working with macros:

- As macros are commands, macro names must be distinct from command names.
- On the other hand, component command names in macros are simply descriptive names for the component command and have no relation to command names in the application. Component command names do not need to be unique to each other or to command names in the application.
- Once component commands are added to a macro, they are duplicated and no longer are associated with the original command. Specifically, if the original command is then modified and saved, the component command in the macro having the same name does NOT change.
- When building a macro via script or RPC, component commands are added to the macro when using the RPC commands SEND_MIPI_CMD or ADD_MIPI_CMD.
- Also, when building a macro via script or RPC, sending a configuration command that is explicitly allowed in a macro (see section 5.8.7) adds the command to the macro. On the other hand, sending a configuration command that is not explicitly allowed in a macro is instead immediately executed and NOT added to the macro.

5.9 Phy Commands

Commands in the “Phy Commands” category of the “Pkt Type” drop-down control invoke lower-level behaviors and modes of the DPhy Generator instrument.

These consist of the following command types, described subsequently:
5.9.1 Clock On / Clock Off

There are two Phy commands that control clock behavior in a macro: “Clock On’ and “Clock Off”. These commands operate as expected, with behavior that prevents illegal duplicate clock on/off sequences, that is:

1. If the clock lane is off (i.e. in LP11) in a macro when the “Clock On” command is sent, the clock lane outputs proper DPhy signaling to turn the clock on at the current “HS Freq” setting. If the clock is already on, the lane clock remains running and no additional signaling occurs as a result of the command.

2. If the clock lane is on in a macro when the “Clock Off” command is sent, the clock lane outputs proper DPhy signaling to turn the clock off (i.e. transition to LP11). If the clock is already off, the lane clock remains off and no additional signaling occurs as a result of the command.

For further discussion of clock lane behavior, please see section 4.3.

5.9.2 ULPS

The ULPS command causes the designated lanes to enter the ULPS state. The LaneMask[4:0] argument indicates which lanes are to transition to ULPS (with bit 0 representing lane 0, bit 1 representing lane 1, etc. and bit 4 representing the clock lane). This command implicitly embeds a Wait Host Event command following the ULPS entry sequence, which waits for an event signal that can be generated by the user using the “Host Event” button of the main window. Behavior is as follows:

When the command is sent, the PG outputs the ULPS entry sequence on selected lanes and continues to run as the instrument holds lanes indefinitely in ULPS. During this time, status indicates that the PG is “Waiting Host Event”. Until this event is seen (or the PG stopped), lanes remain in ULPS. When the host event occurs, the PG outputs the ULPS exit sequence on selected lanes and returns to LP11.

Note that this command can be looped like most commands. If the “Loop Commands” option is checked, then the ULPS command repeats after the Host Event occurs. Please note that, from the user’s perspective, this can be confusing, as nothing seems to change since the PG status remains static: the PG continues to run and the “Waiting Host Event” message is still displayed.

---

14 The “Clock On” command can also be sent as a single command to turn the clock on briefly before it is turned off at the end of the command, but this is only be useful for low-level testing.
5.9.3 BTA

BTA (bus turn-around) is a handshake protocol to transfer bus ownership to the DUT. (applicable only in DSI). Read commands by default have their BTA argument set to “Yes” and this argument can be set to “Yes” by the user for other commands as well. When BTA is set, the BTA signaling sequence is appended to the command. In addition, a BTA sequence can also be sent on its own, without accompanying data by selecting “Send BTA” in the “Pkt Type” command field.

After a BTA sequence is sent, the DPhy Generator suspends program output and places its drivers in high-impedance until it receives a return BTA sequence from the slave DUT or times out. When a return BTA sequence is seen on the bus, the instrument drives a BTA acknowledgement sequence and then resumes program output. In the event of a BTA timeout, the instrument resumes program output without sending a BTA acknowledge.

This wait-for-BTA process can be initiated without first sending an initial BTA sequence by using the “Wait For BTA” command. This command does not transmit any data on the bus but simply drives high-impedance and waits for a BTA sequence from the slave DUT or eventually timing out.

Notes:

- These commands are most useful when embedded in a macro with other MIPI commands. Component commands in the macro following a “Send BTA” or “Wait For BTA” are not output until the return BTA is recognized or the BTA timeout has expired.

- The BTA timeout is set in the Instrument Configuration dialog with the control “BTA Wait Time”. To avoid any timeout, the user can set the “Disable Command Timeout” option (Options menu). If necessary, the “Stop PG” button can be used to terminate a command waiting for a return BTA.

- While the DPhy Generator is waiting for a return BTA from the DUT, the main window status bar displays “Waiting on BTA…”.

5.9.4 Escape Command

The Escape Command option lets the user send a Phy escape command byte. The only argument is the command byte to send. Note that this command is different than a packet sent in LPDT mode. LPDT mode uses an escape command byte of 0x87 to put the receiver in LPDT mode, and then sends the packet bytes.

5.9.5 Skew Calibration

The Skew Calibration command is a command that sends a deskew burst on all active lanes as defined in DPhy 1.2. This is used for receiver calibration at high bit rates (generally greater than 1.5 Gbps).
The deskew burst sequence is similar to an HS burst except that the sync byte is replaced by 16 ones (i.e. 0xffff) and a clock pattern ‘0101…’ is sent instead of packet data on all active lanes.

The Skew Calibration command has one argument which is the duration of the burst in UI (quantized to a multiple of 2). If UI is set to zero, the SkewCal setting in the current DPhy Timing Configuration is used.

The user can send the Skew Calibration command as a single command or embedded in a macro. In addition, the Frame Timing dialog allows the user to enable sending a deskew burst at the start of each frame in a single or looping sequence. This applies to both video-mode commands and video-mode frames sent in a macro.

To enable sending a deskew burst at the start of each video frame, check the “Enable Skew Cal” checkbox in the Frame Timing dialog (Timing Cfg… button in the main window). This enables a textbox next to the checkbox to enter in the burst duration in UI. As with the Skew Calibration command, setting this value to zero uses the SkewCal setting in the current DPhy Timing Configuration.

5.9.6 Alternate Calibration

The Alt Calibration command is a command that sends an alternate calibration sequence on all active lanes as defined in DPhy 1.2. This is used for receiver calibration at high bit rates (generally greater than 1.5 Gbps).

The alternate calibration sequence is similar to an HS burst except that the sync byte is replaced by 0x0f and a PRBS9 pattern is sent instead of packet data on all active lanes.

The Alt Calibration command has one argument which is the duration of the burst in UI (quantized to a multiple of 2). If UI is set to zero, the AltCal setting in the current DPhy Timing Configuration is used.

According to the DPhy specification, the alternate calibration sequence can optionally be sent following a skew calibration sequence. However, DPhyGenCtl allows independent sending of the Alt Calibration command as a single command or embedded in a macro. In addition, the Frame Timing dialog allows the user to enable sending an alternate calibration sequence at the start of each frame in a single or looping sequence. This applies to both video-mode commands and video-mode frames sent in a macro. Note that skew calibration precedes alternate calibration if both options are enabled in the Frame Timing dialog.

To enable sending an alternate calibration sequence at the start of each video frame, check the “Enable Alt Cal” checkbox in the Frame Timing dialog (Timing Cfg… button in the main window). This enables a textbox next to the checkbox to enter in the burst duration in UI. As with the Alt Calibration command, setting this value to zero uses the AltCal setting in the current DPhy Timing Configuration.
5.9.7 TGR Data Sequence

The TGR function has been adopted from CPhy to provide low-level support for arbitrary HS data transmission, which can be useful for general testing.

The TGR Data Sequence command starts by sending an HS burst entry sequence on all active lanes using the current DPhy timing settings. Note that no Sync byte is sent. Following the HS burst entry sequence, all active lanes loop on a specific data pattern defined by the Params[] argument, which is a variable-length list of data bytes. The pattern loops for the number of iterations specified by the LoopCnt parameter, eventually exiting back to LP11 with the HS burst exit sequence.

If LoopCnt is set to zero, the burst data loops indefinitely in HS mode, never completing a single burst until the “Stop PG” button is pressed (at which point the HS burst exit sequence is output and the PG becomes idle). Otherwise, after one complete burst has been sent, the burst is repeated again and again, only stopping when the “Stop PG” button is pressed. Note that this outer looping occurs even if the “Loop Commands” option is unchecked.

Note that one constraint on the LoopCnt parameter is that the total number of looped bytes in the sequence (i.e. LoopCnt * sequence bytes) must be greater than or equal to 64. Otherwise, an error message is displayed.

5.9.8 TGR Bit Sequence

The TGR Bit Sequence command is nearly identical to the TGR Data Sequence command (see previous section) except that the user indicates sequence bits (0 or 1) rather than bytes. In this case, the total number of looped bits in the sequence (i.e. LoopCnt * sequence bits) must be greater than or equal to 256. Otherwise, an error message is displayed.

5.9.9 PRBS9 Sequence

The PRBS9 Sequence has been adopted from the CPhy specification to provide low-level support for randomized data transmission, which can be useful for general testing.

The PRBS9 Sequence command starts by sending an HS burst entry sequence on all active lanes using the current DPhy timing settings. Note that no Sync byte is sent. Following the HS burst entry sequence, each active lane outputs a specific data pattern generated by the PRBS9 algorithm, which consists of a sequence of 16-bit randomized words having a length specified by the WordCnt parameter. After the data sequence is complete, lanes are returned to LP11 with the HS burst exit sequence.

If WordCnt is set to zero, the burst data loops indefinitely in HS mode, never completing a single burst until the “Stop PG” button is pressed (at which point the HS burst exit sequence is output and the PG becomes idle). Otherwise, after one full burst has been sent, the command has completed, but like other commands may optionally be looped either in a macro (using Loop Start and Loop End commands) or as an individual command using the Option->Loop commands menu option).
Note that the infinite looping that occurs when the WordCnt is 0 requires a seamless looping sequence. For PRBS9 and PRBS 11, only a subset of 16-bit seed values actually generate a seamless looping sequence because only the least-significant 9 or 11 of the 16 bits are independent (that is, bits 9-15 and 11-15 are dependent on the least-significant bits in the seed for PRBS9 and PRBS11 respectively). Thus, when WordCnt = 0, software enforces this dependency and bits 9-15 and 11-15 are effectively ignored for PRBS9 and PRBS11 sequences respectively in order to generate a correct, infinitely looping sequence.

In addition to the WordCnt parameter, the PRBS9 Sequence command accepts four more arguments, initializing each lane’s PRBS generator.\(^\text{15}\) Optionally, the user can specify identical seed values causing all active lanes to have identically synchronized data patterns:

- L0_Seed[15:0] – lane 0 starting PRBS seed (should be nonzero)
- L1_Seed[15:0] – lane 1 starting PRBS seed (should be nonzero)
- L2_Seed[15:0] – lane 2 starting PRBS seed (should be nonzero)
- L3_Seed[15:0] – lane 3 starting PRBS seed (should be nonzero)

5.9.10 PRBS11 Sequence
The PRBS11 Sequence is nearly identical to the PRBS9 Sequence (see previous section) except that the PRBS algorithm is generated from an 11-bit LFSR.

5.9.11 PRBS18 Sequence
The PRBS18 Sequence is nearly identical to the PRBS9 Sequence and PRBS11 Sequence (see previous sections) except that the PRBS algorithm is generated from an 18-bit LFSR. To this end, the initial seed parameters are 18-bit values.

5.10 File Command
The File Command is general-purpose, low-level command in DPhyGenCtl that uses a text file as input to define arbitrary LP and HS DPhy signaling sequences. Using special component command syntax, low-level LP and HS lane states and higher-level packet data bytes can be intermingled to create test sequences, including non-standard and error packets. Command syntax also supports features such as automatic ECC, CRC and WordCnt generation, HS burst signaling (e.g. HS entry/exit and sync), packet data demultiplexing, clock on/off control, looping, subroutines, expression syntax with variables, and nested command files.

The File Command can be found in the “Miscellaneous Commands” category of the “Pkt Type” drop-down control and has one argument (“File Name”) that specifies the source text file name to parse and use to construct the DPhy signal. The command is sent like any other normal command and can be part of a macro. The DT Mode setting is ignored.

\(^{15}\) Note that inactive lanes remain in LP111 and their seed values have no effect on output.
when sending the File Command, but other GUI settings such as the HS Bit Rate, LP Freq, Lane Cnt, and DPhy bus timings may affect output, depending on the component commands used in the file.

In constructing an output stream, the File Command script is parsed in sequence: one line at a time, one component command at a time. After parsing the entire file, the result is a single output stream that is then added to a macro or sent on to the DPhy bus.

Note that the File Command supports Internal File scripts, that is, scripts embedded directly into the File Name argument (no script text file required). Please see section 6.3 for more information.

New with DPhyGenCtl version 3.6 is the ability to use a File Command script to generate payload data for packet commands that use a data file, including and especially video-mode commands and WriteMemory commands. Command support for rescaling and format conversion is provided, making this a very general and useful feature for arbitrary test pattern generation.

Complete information about the File Command is described in the document: “File Command.pdf”. This document is available in Help form from the About menu of DPhyGenCtl or through the Start->DPhyGenCtl menu link. Example File Command scripts are also provided with the DPhyGenCtl installation. A link is provided to these files at: Start->DPhyGenCtl->File Command Scripts.

5.11 PG File Command

A useful feature of DPhyGenCtl is the “PG File” command, which allows the user to download and play a program that was previously compiled and saved to a file called a PG file (extension .pg). Any command that causes a PG program to be built and output on the DPhy bus can be pre-compiled in this way, including individual MIPI commands, macros, video commands, etc.

The main advantage to using PG files is that the command sends very quickly. As the program for the command is already pre-compiled, the only time incurred is the time it takes to download the program to the instrument. Thus, good candidate commands for saving to a PG file are long video sequences, DSC encoded video sequences, and very long macros with many component commands.

Another advantage to using PG files is that the command and its complete playback configuration are stored together in a single file. All configuration settings that affect program construction such as lane count, bit rate, frame timing, DPhy timing, options, etc. are embedded in the compiled program at the time the PG file is created. Thus, two notable characteristics when a PG file is sent are:

1. Current GUI configuration settings that usually affect program construction are ignored. Settings that still affect PG File program behavior are the options “Disable Event Timeout” and “Enable Command Insertion” as well as all runtime settings in the Instrument Configuration dialog such as voltages, delays, etc.
2. With only two exceptions, the current GUI configuration remains unchanged after the PG File command is sent. Only the “HS Bit Rate” and “Lane Cnt” settings are changed to the values stored in the PG file when the command is sent.

5.11.1 Creating A PG File

To create a PG file, do the following:

1. First, select the Cmd to send in the Cmd Name drop-down control or choose a Pkt Type and define a new command using the command definition controls.

2. Then, select the menu option “Send Cmd To PG File” (File menu) and enter the PG file name in the dialog box that appears. The command program will be compiled and saved to the PG file with extension “.pg”.

5.11.2 Sending A PG File

To send a PG file, first create a PG File command to reference the PG file. Use the PktType control to select “Miscellaneous Commands” and then the “PG File” submenu. Then, type in or browse for the PG file to use in the File Name command field. Finally, you can optionally name and save it as a Cmd or send it directly using the Send button.

Note that a PG File Cmd can automatically be created when you create the PG file by checking the GUI option:

**Auto-define new “PG File Cmd” after “Send Cmd to PG File” operation**

This option can be found in the “Set GUI Options…” menu in the Options menu.

5.12 Command Buttons

The top-right pane of the main application window consists of four tab pages of 30 command buttons (labeled Cmds1, Cmds2, Cmds3, Cmds4). Clicking on the tab page header makes the 30-button command set available for use.

Command buttons can be associated with named commands by the user, allowing single-click sending of the named command on to the DPhy bus. When assigned with commands, buttons are labeled with their command name and enabled. Otherwise, they are disabled and show the label “<unassigned>”. Note that separate button pages are associated with DSI and CSI command sets, activated when the protocol is selected using the Standard menu.

Command buttons have an associated context menu, brought up by right-clicking on the button. The operations available from the button context menu are as follows:

- **Assign Current Cmd**: assigns the currently selected command in the Cmd Name drop-down control to the button
- **Assign Cmd**: assigns a named command selected from a sub-menu to the button
- **Remove Assignment**: removes the current command assignment from the button
- Page 65 -

- **Remove All Assignments on Current Cmd Page**: removes all command assignments from all 30 buttons on the button page.

- **Remove All Assignments on All Cmd Pages**: removes all command assignments from all button pages

- **Set Button Tooltip**: sets a tooltip string to display when the mouse hovers over the command button. To clear the tooltip, set the tooltip to the empty string. Note that removing a button assignment also clears the tooltip string.

- **View Current Cmd**: fills in the argument field controls with values associated with the command. For a macro, argument fields for the first component command in the macro are shown. In addition, the Macro tab is selected and the macro command definition is shown as read-only.

- **Edit Current Cmd**: for non-macro commands, this command is identical to View Current Cmd. For macros, in addition, the macro command definition is brought up in edit mode.

Note that, unlike application settings such as option settings, DPhy timing definitions, frame timing, and instrument configuration settings, command definitions and button assignments are *not* automatically saved when the application closes. Instead, command definitions and button assignments must be saved explicitly to a configuration file using the Save Cfg… menu option (File menu).

**5.13 Operation**

**5.13.1 Sending a Command**

Once the DPhy Generator instrument, frame timing, and DPhy timing configurations are set and desired options are checked, commands may be sent to the DPhy Generator for output. Unnamed commands are sent after selecting the packet type and filling in the command arguments simply by clicking the Send button. Named commands, once defined, are sent by selecting the command name from the Cmd Name drop-down control and clicking the Send button. Alternatively, if a named command has been assigned to a button, left-clicking the button sends the command to the DPhy Generator for output.

After the user sends a command, messages in the status bar updates progress. During this time, DPhyGenCtl performs the following tasks:

- The command is parsed and any necessary external file data imported (and decoded in the case of BMP files)

- MIPI protocol packets are built along with any necessary signaling structures (i.e. SOT, EOT, BTA, etc).

- Packet data is packed into internal data records and a play sequence is constructed for the DPhy Generator to use during output.

- Data records and play sequence are downloaded to the instrument.
The internal PG of the instrument is “Run”, initiating output, with control returning to the user at this point. Sending of the command is complete.

However, if the command is a looping command, or contains event wait component commands, the DPhy Generator continues to run. Information in the status pane of the main window updates on-going operation.

5.13.1.1 Stop PG
As described above, the sending of commands goes through several stages of processing, some of which may take some time. Program download, in particular, can take tens of seconds to complete for video commands, when large blocks of video data are sent. DSC frame compression also can be time-consuming, depending on the frame size. During this time, the user may click the “Stop PG” button (located in the bottom-right pane of the main window) to abort command sending. In addition, once a command is running and the PG is actively looping (or waiting on an event), “Stop PG” may be clicked to terminate operation.

5.13.1.2 Restart PG
The “Restart PG” button in the bottom-right pane of the main window is used to resend the previous command, bypassing the potentially lengthy download process. This is useful, in particular, for video commands. When the PG is restarted, all timing configuration and parameters such as frequency, lane count, and clock start/stop mode from the original command are used (ignoring any changes since the command was sent).

5.13.2 Status
During operation, additional status is displayed in the lower-right pane of the DPhyGenCtl main window. This status is updated every second and includes the following:

- The PG run state (running or idle)
- The memory use of a running program (as a percent available in the instrument)
- The HS Bit Rate of a running program.
- The data lane status (enabled, ULPS, waiting on event, etc)
- Whether any LP contention has been detected since the last status reset
- Read response data received from the DUT after a BTA.\(^\text{16}\)

5.13.2.1 Contention Detection
The DPhy Generator is equipped with contention and data receivers on lane 0, whose thresholds can be set by the user in the Instrument Configuration dialog (see section 5.4.2

\(^{16}\) Note: read response data is only displayed after a running program has stopped or the user explicitly requests that read response data should be read from the instrument with the “Get DUT Resp” button.
for more details). When the instrument drives an LP high voltage but detects a voltage below the LP High contention threshold, an LP high fault is detected. When the instrument drives an LP low voltage but detects a voltage above the LP Low contention threshold, an LP low fault is detected.

As these faults can occur on either LP signal wire this results in four possible contention states. The mnemonics displayed in DPhyGenCtl for contention detection is as follows:

- **LP-Tx0** – contention detected on the LP- wire of lane 0 when transmitting LP0
- **LP+Tx0** – contention detected on the LP+ wire of lane 0 when transmitting LP0
- **LP-Tx1** – contention detected on the LP- wire of lane 0 when transmitting LP1
- **LP+Tx1** – contention detected on the LP+ wire of lane 0 when transmitting LP1

Once contention is detected, flags are held until a subsequent command is sent or the Status Reset button is pressed to clear state. Note also that the aggregate contention state is reflected on the Evt1 signal of the instrument back-panel (see section 2.4), allowing for instrument trigger on the onset contention.

### 5.13.2.2 DUT Response

When a command or macro containing a BTA is sent, the DPhy Generator monitors the link for an LPDT response command from the DUT. The DUT response (if any) is displayed in the status pane of the main window as the string “DUT Resp: “ followed by the first number of hex data bytes. If the response contains more than 12 bytes, a button labeled with an ellipsis (“…”}) appears so the user can click to view the entire response data in a dialog. Note that if the program is looping, DUT response data does not appear until the program is stopped or the user clicks the “Get DUT Resp” button.

To convey the LP signaling states transmitted by the DUT in generating its read response, an extra partial byte of data is included before the actual DUT response message. In particular, the first byte of each response conveys the initial two bits seen during escape entry (LP10, LP00, LP01, LP00), which is interpreted as binary ‘1’ followed by binary ‘0’ or equivalently a 0x1 data byte.

In addition, a special flag (0x100) is set in this value to indicate it represents a new escape-entry command. This allows for multiple responses to be queued and subsequently easily parsed by the user. Thus, to summarize, the first value displayed for each escape entry command should be 0x101.

Subsequent bytes displayed after escape-entry, represent the command data, starting with the escape command, which is expected to be 87h for an LPDT command. Thus, the first header byte of each DUT response packet will be conveyed in the second byte of the displayed DUT response data following each 0x101 value.

The DUT response buffer is reset every time a DPhyGenCtl command is sent, but this could consist of a macro with multiple read commands. The response buffer is relatively
large (4 Kbytes) and thus can capture a significant amount of data from multiple reads, which are simply concatenated in the buffer.

![DUT Response Dialog](image)

**Figure 13 – DUT Response Dialog**

Example:

During video-mode, say the user inserts four read commands over the course of a test and their responses are queued. When “Get DUT Resp” button is pressed and the ellipsis button is pressed, the DUT response bytes might look like those in Figure 13.

Each response is delimited by the escape-entry value of 101h. This is followed by 87h for the LPDT command byte and then a DataID of 11h, indicating a generic short read response packet.

Note, there are two RPC commands that can be used to obtain the DUT response:

- GET_DUT_RESPONSE can be used programmatically to obtain the last response from the DUT.
- SAVE_DUT_RESPONSE can be used either in a script file or programmatically to save or append the last response from the DUT to a text file.

Please see the DPhyGenCtlRPC manual for more information.
5.13.3 Command Insertion

Command insertion is the ability to insert commands into an actively looping stream, whether in a video-mode command or macro. While video-mode commands automatically define an insertion point in the first vertical blanking line of a frame, the user may also explicitly define an insertion point in a macro, denoting the location where the inserted command should output. The “Cmd Insertion Point” command is used for this purpose.

The following describes command insertion behavior:

- Command insertion is enabled using the “Enable Command Insertion” option. Checking this option means that a command sent while a program is running is intended for insertion.
- When command insertion is enabled, to send a subsequent command but not insert it, either first click the “Stop PG” button or uncheck the “Enable Command Insertion” option.
- An inserted command may be sent in HSDT or LPDT mode and inherits the LPFreq, HS Bit Rate, and LaneCnt settings used in the looping program (regardless of possibly edited GUI control settings).
- If the inserted command requires more time than that reserved by the Cmd Insertion Point (via its Delay parameter), the looping program is suspended until the inserted command completes.
- When a command is inserted, DPhyGenCtl checks to see if it can detect the insertion command code in the output stream. If it is not detected within ½ second, an error is reported. To disable this check, select the “Disable command timeout” option. This option should be checked if the “Wait on external event to start” option is enabled or the macro contains a “Wait Ext Event” command.
- If a command is inserted when the PG is waiting on an external event (and the command timeout is disabled), the inserted command is queued to be sent when output resumes and the insertion point is reached.
- If a macro contains multiple command insertion points, an inserted command is output at the next encountered insertion point. Unless sequencing is controlled via external events, the user has no practical control over which command insertion point is used for the inserted command.

5.13.4 Controlling TrigOut

The DPhy Generator has a TrigOut front-panel signal that can be controlled both through the GUI and stream commands. It can be used as a scope or DUT-related triggering event.

The GUI main window has a “Trig Event” button that generates a pulse on the TrigOut signal when pressed. The event occurs whether or not the PG is running. However, note that the front-panel TrigOut does not occur if stream output is stalled waiting on an event.
The duration of the pulse is configured in the Instrument Configuration dialog via the “Trig Pulse Width” control.

Also, the “Assert Trigger” command, which can be embedded in a macro, allows full control and timing of the TrigOut signal, allowing direct setting of the signal level (high or low), toggling state, or generating a pulse sequence (see section 5.6.7.15).

The TrigOut signal is duplicated (with some differences in behavior) on the back-panel GPO0 signal (see section 2.4 for back-panel description). Like the front-panel TrigOut, the back-connector signal is controlled both from the “Assert Trigger” command and the “Trig Event” button of the DPhy Generator GUI. However, the back-panel TrigOut has two differences in behavior from the front-panel TrigOut:

1. It does not have even nearly synchronous timing with the command in the stream output when controlled via the “Assert Trigger” command, occurring well before command output. The time difference is somewhat variable and is on the order of microseconds.

2. Unlike the front-panel Trig-Out, it supports “Trig Event” output even when output is stalled waiting on an event.

### 5.13.5 External Event Triggering

The GPI0 input on the back-connector of the DPhy Generator pin (see section 2.4) can be used as an external event signal for controlling output flow control. The triggering event on this signal is a rising edge (logic level ‘0’ transitioning to a ‘1’). When detected, the latency of the event signal is bit-rate dependent, but generally is on the order of 100 ns.\(^\text{17}\)

Currently, there are three ways this signal can be used:

1. To control when command output begins
2. To control frame advance during video sequence playback
3. To control when component commands in a macro are output

These ways are described in the next sections.

#### 5.13.5.1 Controlling When Command Output Begins

The option “Wait on external event to start” (Options menu) allows users to configure the PG to wait for an external trigger event before command output begins (including video-mode commands). When this option is enabled, commands that are sent do not immediately output on the DPhy bus. Instead, while the stream is prepared and downloaded to the instrument as usual, output is held off until the external event is detected.

\(^{17}\) However, the effective latency for the external input event when used for advancing video frames is much longer (one or two frames) due to the video program and pipeline architecture.
5.13.5.2  Controlling Frame Advance During Video Mode
The option “Advance Frame On External Event” in the Frame Timing dialog (see section 5.7.3.6) allows video-mode to be configured such that each frame loops indefinitely until the external event is detected. When the event is detected, output moves to the next frame in the sequence.

5.13.5.3  Controlling Macro Component Command Output
The command “Wait Ext Event” (section 5.6.7.14) can be used to pause output in a macro until the external event is detected. When the generator is paused, the DPhy bus is held in a static LP state as specified by the user.

Note that the “Disable Command Timeout” option (Options menu) applies in this case. If this option is checked, the instrument pauses and waits indefinitely for the external event. Otherwise, there is a static timeout period of one millisecond after which the program continues automatically.

5.13.5.4  Triggering the External Event Signal Via Software
Note that the HostEvent button in the main window can be used to cause the External Event signal (i.e. GPI0) to fire. This allows the user to test without external hardware connected or otherwise simply use a GUI button (or RPC command) for program flow control.

5.13.6  Wait Events
During program output, there are several events that cause output to suspend (in an LP state) until the event fires. They are:

1. **BTA Ack**: triggered by the DUT responding with the proper LP acknowledgement sequence immediately following a BTA. The default timeout associated with this event is 10 us and is not user-configurable.

2. **BTA Response**: triggered by the DUT eventually responding with a proper BTA response sequence after receiving the bus via a BTA. The default timeout associated with this event is 100 us but can be set by the user in the Instrument Configuration dialog.

3. **External Event**: triggered by a rising edge on the GPI0 input pin on the P344 back connector. The default timeout associated with this event is 1 ms and is not user-configurable.

4. **Host Event**: triggered in software via the HostEvent button of the main GUI window. There is no timeout associated with this event.

Actions that are associated with one or more of these events are shown Table 6:

<table>
<thead>
<tr>
<th>Action</th>
<th>Associated Event(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending a MIPI packet with it BTA parameter set to</td>
<td>BTA Ack, BTA Response</td>
</tr>
</tbody>
</table>
Most events as noted in their description have timeouts. Once program output has been suspended waiting on an event longer than its timeout, program output automatically resumes as if the event occurred.

If timeouts are not desired, for example during low-level testing, they can be disabled via the option: “Disable Event Timeout” (Options menu). When event timeouts are disabled, another feature of the software may prove useful. In particular, the Host Event button can be used to force any event causing program suspension, allowing simulation of the event.

### 5.13.7 Causing Packet Errors

The DPhyGenCtl GUI supports the ability to modify a packet’s ECC and CRC fields to cause receive errors in packets. Normally, when a packet type is selected for a command in the main window and its parameters set, read-only fields are displayed showing the DataID and ECC for short packets and, additionally, the WordCount and CRC for long packets. Checkboxes next to the ECC and CRC fields allow user modification of these fields to cause a receive error in the packet.

To change the ECC or CRC, simply check the associated checkbox, making the field value editable. When the control is unchecked, the correct ECC or CRC value is recomputed and the field is restored back to its original read-only state.

This capability applies to all CSI/DSI commands, including those within macros, except for video-mode commands. For video-mode commands, there is no ability for the user to set the ECC or CRC of any of the video frame packets. However, payload data errors can be introduced using the “Video Error” field (see section 5.7.2.2).

When applied to the Write Memory commands, if the command is partitioned into multiple Write Memory commands, the user-set ECC and/or CRC applies only to the first Write Memory command. Remaining Write Memory commands are always built with their correct ECC and CRC.

An additional mechanism for introducing packet errors is described in the description of RPC. In addition to allowing the ECC and CRC to be set, the SEND_IMPAIRED_MIPI_CMD RPC call allows any byte in a packet to be XORed with an error mask before it is sent. Please see the description of this command in the DPhyGenCtlRPC manual for more details.
5.13.8 “Hold Trail” Test Mode
The “Hold Trail” test mode is enabled by checking the option “Enable ‘Hold Trail’ Test mode” (Options menu). When this mode is enabled, non-video, non-macro, non-looping packets sent in HS mode do not terminate their burst as normal. Instead, they hold their HS Trail state on the bus indefinitely, returning to LP11 only after “Stop PG” is pressed by the user (or another command is sent). During this time, the status readout in the main window indicates data lane state as “Holding HS Trail”.

If looping is enabled, the command is loops normally until “Stop PG” is pressed, then the last command iteration holds its HS Trail state and software waits for a subsequent “Stop PG” event to return to LP11.

This mode is not generally useful to most users, but is helpful for low-level testing of certain devices, in particular where results from a PRBS sequence test must be read before the LP11 state resets the device state.

5.13.9 Script Recording
Script recording is a mode in which MIPI commands sent to the DUT are also written as RPC commands to a designated script text file. All commands, including macros and video-mode commands are recorded. After recording, the script file can be sent as any other script file or used as a template for creating additional script files.

In addition, the current configuration state can be written to the script file. This allows the script file to initialize DPhyGenCtl to a particular configuration or be sent to the Moving Pixel Company to document your configuration when requesting assistance.

To enable script recording, select “Start Recording” from the Script menu. When this option is selected, a browse dialog is opened for you to designate the text script file name to use for recording.

Once script recording is enabled, the status bar displays the text “Recording” in a new pane. The script file is initialized with a header containing information about the current software and hardware configuration.

Any MIPI command sent (without error) during recording also causes an RPC command to be appended to the script file. In addition, selecting the menu option “Write Current State” from the Script menu causes the current state to be written to the script file. To end script recording, select “End Recording” from the Script menu.

5.13.10 Updating Firmware
Periodically, new firmware releases may be issued for the DPhy Generator. The latest firmware release can be downloaded from The Moving Pixel Company’s website and (after unzipping) is labeled DPhyGenFirmware_VerX_Y.rbx, where the X and Y represent version and release digits respectively.
To update firmware in the DPhy Generator, perform the following steps:

- Connect to the instrument normally. If for some reason the instrument’s firmware has been corrupted and is non-responsive, it is important in the Connect dialog to check the “Firmware update only” checkbox to prevent interaction with the FPGA.
- Select the Connect->Update Firmware…. menu option to bring up the firmware dialog.
- Click the “Browse” button next to the “Firmware Filename” to select the RBX firmware file on your machine, obtained from the Moving Pixel Company.
- Click the Program button.
- Programming takes a couple minutes, with status updating progress.
- When programming is complete, close the application and power-cycle the instrument. On power-on, you can watch the instrument LEDs for the appropriate sequence: i.e. the red and yellow LEDs alternate for a couple seconds ending with the green LED remaining solidly on.
5.14 Dual-Instrument Operation

Dual-instrument operation refers to the synchronous sending of commands (< 200 ps) using two P344 DPhy Generators. In this mode, one P344 is designated as the master and one P344 is designated as the slave and they share a common reference clock via a cross connector on the back panel of the instrument.

While each DPhy bus in the dual-instrument configuration runs independently, because they run on a common time-base and are started synchronously, their output remains in lock-step, provided they are running structurally the same programs. Thus, a requirement for dual-instrument operation is that the software configuration of both master and slave is identical, including options, Frame Timing, DPhy configuration, DSC configuration (if compressed video is used), etc. Software enforces this requirement automatically by mirroring the master configuration in the slave whenever a command is sent. Note that instrument configuration such as voltages, delays, etc. can still be adjusted independently, if desired.

DPhyGenCtl version 3.6 (or better) is required to support dual-instrument operation. While both instruments have a controlling instance of DPhyGenCtl software, the user only generally interacts with the master DPhyGenCtl software to control both instruments. The slave DPhyGenCtl software is launched from the master and is hidden during normal operation, acting as a server for the master software to control the slave instrument.

5.14.1 Hardware Configuration

Dual-instrument operation requires two P344 RevB instruments running firmware 2.3 or better. Revision B instruments are the latest P344 hardware and are indicated with a ‘B’ next to the firmware number in the main window status bar.

Setting up hardware for dual-instrument operation is straightforward:

1. Setup both P344 instruments on the same computer, connecting both to a USB port on the machine and deciding which one is to be the master. Note: the master outputs the left-side image when “Left/Right Image” is selected for the dual-interface mode setting for video output.

2. Cross-connect the master and slave back-panel synchronization ports, using the provided mictor cables (i.e. connect master SyncOut to slave SyncIn and vice-versa).

5.14.2 Software Initialization

Once both P344 instruments are configured and powered-on, initialize software for dual-instrument operation with the following steps:

3. Launch DPhyGenCtl and connect to the master P344.

4. Bring up the Slave Sync Dialog using the “Connect->Sync With Slave…” menu option.
5. Enter the RPC port number to use for the slave server software. The port number can be any unused port on the host machine up to 64K. Generally, a number greater than 5000 should be available.

6. Select the serial number of the slave P344 (click the Scan button if necessary to update the USB device list).

7. Click OK to launch the slave server software. The server GUI will be hidden by default.

If successful, the master GUI will display "Slave GUI launched successfully" and its status pane in the main window will adjust to reflect both the master and slave status.

### 5.14.3 Slave Server GUI

The slave server GUI generally runs in the background, handling requests from the master DPhyGenCtl software. If desired, the slave server GUI can be made visible by clicking the “Connect->Show Slave GUI” menu option.

When visible, the slave server GUI background is gray and most controls are disabled as it is not intended for the user to interact with the slave server GUI during normal operation. This is because most configuration options, including tmust be identical between master and slave.

In some cases, however, the user may want to discontinue dual-interface operation and control the slave instrument directly. In this case, the user can click the “Connect->Enable RPC” menu on the slave server GUI to disable RPC, reverting both the slave and master GUIs to normal single-instrument control.

### 5.14.4 Instrument Configuration

As mentioned previously, when DPhyGenCtl is controlling a dual-instrument system, almost all configuration settings for the slave are enforced to be the same as the master. This includes system options, WriteMemory configuration, DSC configuration, DPhy timing, lane count, HS and LP frequencies, and frame timing. The user does have the option, if desired, to control master/slave instrument configuration such as voltages, lane delays, lane mapping, etc. independently.

To this end, the checkbox “Link to slave” is provided in the Instrument Configuration dialog to link or de-link dialog settings between the master and slave. Checking this option, enforces that all slave settings mirror those of the master. Unchecking this option removes this enforcement, and enables the “Slave Cfg…” button in the Instrument Configuration dialog. This button brings up a second separate Instrument Configuration dialog for slave configuration.

### 5.14.5 Operation

Once a slave instrument is connected, commands are directed to the master, slave, or both master and slave using the “Act Link(s)” control in the main window. Setting this control to “Master” or “Slave” causes commands to be sent only on the selected instrument.
Setting this control to “Master/Slave” causes commands to be sent synchronously on both instruments.

Synchronization of master and slave is achieved using a common reference clock and synchronized program start. After the program is running, the instruments are essentially free-running and thus will only remain synchronized as long as the programs are structurally identical, configuration options and settings are identical, and there are no asynchronous waits in the program.

DPhyGenCtl enforces the first two conditions but allows sending of programs with asynchronous waits. If this is true, synchronization will be lost between master and slave and there is no detection or indication of this condition. Example cases where synchronization is lost are:

- Read commands or commands with “BTA” argument set to “Yes”, except possibly when used as an inserted command during video-mode. If the DUT response and return BTA complete before the vertical blanking line timing completes, synchronization will be maintained.
- With one exception, use of the “External Event” signal, including “Wait Ext Event” command in a macro and “Advance Frame On External Event” option in the frame timing dialog. The exception is the option “Wait on external event to start”, which works as desired in master/slave mode. In this case, GPI0 on the master should be used as the external event signal.
- Use of the “Stop PG” button. As the slave is stopped before the master, program termination is not synchronized.
- Use of the ULPS command. ULPS exit is not synchronized.

5.14.6 Sending Video

This section describes how synchronized video is sent in a dual instrument configuration.

5.14.6.1 Image Partitioning

When sending video in a dual instrument configuration, whether via command mode or video-mode, a new setting in the Frame Timing dialog is enabled and available to the user. This setting is called “Dual-Interface Mode” and controls how video frames are partitioned across master and slave. Options are as follows:

- Clone Image: full frames from the video-command image file or sequence are output on both master and slave (i.e. identical sequences are output on master and slave).
- Dual Image: full frames from the video-command image file or sequence are output on the master. In addition, full frames from a separate image file or sequence are output on the slave. Slave image file names are derived from master image file names using the convention described below.
- Left/Right Image: the left-half of frames from the video-command image file or sequence are output on the master. The right-half of frames are output on the slave.

It is important to note that Frame Timing parameters always define the full input-frame dimensions, blanking, and overall output timing, regardless of the dual-interface mode setting. When “Clone Image” or “Dual Image” is selected, the frame timing reflects both the input-frame and output-frame (per master/slave interface). When “Left/Right Image” is selected, the output frame timing (both dimensions and blanking) is half of the input-frame timing.

For example, in the “Left/Right Image” case, a 1920 by 1080 frame timing definition results in an output frame on each master/slave interface of 960 by 1080 (with half the blanking times described in the frame timing dialog). The HS Bit Rate is halved, since it describes the output clock rate on each interface, causing the Line Time, Pixel Clk, and Frame Rate to remain the same.

Note that, when operating in dual-instrument mode, the output frame timing does not change when the “Act Link(s)” setting is changed. In particular, if the dual-interface mode is set to “Left/Right Image”, only the left or right half-frame is output even if the active link is only set to Master or Slave only.

5.14.6.2 Dual-Image Mode File Naming

Video-mode commands and WriteMemory commands are given an image file name as a parameter to the command. For video-mode commands, there already exists a special naming convention to allow for multiple frames in a sequence to be output. This naming convention has been extended for video-mode and defined for WriteMemory commands to support dual-image mode video output.

Specifically, file names used in dual-image mode require that the file names, not including extension, end in “A” or “B” (e.g. “ImageA.bmp” and “ImageB.bmp”). The “A” filename is specified in the command and the “B” filename is implicitly used. The “A” image is sent out the master and the “B” image is sent out the slave.

For video-mode sequences, the protocol already exists to use an incrementing number at the end of files (e.g. “Image1.bmp”, “Image2.bmp”, “Image3.bmp”). For dual-image mode, file names should have “A” or “B” following the incrementing number (e.g. “Image1A.bmp”, “Image1B.bmp”, “Image2A.bmp”, “Image2B.bmp”, etc.).

Finally, for convenience, “A” or “B” dual-image sequences can be used with “Clone Image” and “Left/Right Image” modes as single sequences. For example, using the file name “Image1A.bmp” with a Frame Count of 3 in “Clone Image” mode sends the images “Image1A.bmp”, “Image2A.bmp” and “Image3A.bmp” out both master and slave.

5.14.6.3 Command Insertion Behavior

Command insertion is allowed during video mode and will maintain synchronization with the following caveats:
As inserted commands are sent during a vertical blanking line, they must be short enough to complete within an active packet time (which is the time allowed for insertion during a vertical blanking line). If inserted commands do not complete within this time, synchronization of master/slave video will be lost and loss of synchronization will not be detected.

If inserted commands include a BTA (e.g. read commands), both the sending of the inserted command and the DUT response must complete within an active packet time (which is the time allowed for insertion during a vertical blanking line). If the DUT response does not complete within this time, synchronization of master/slave video will be lost and loss of synchronization will not be detected.

There is no guarantee of inserted-command synchronization between the master and slave. Because the inserted command is sent on the slave before it is sent on the master, it is likely to occur in an earlier frame on the slave than on the master.

### 5.14.7 Master/Slave RPC

New RPC commands have been added to support dual-instrument configurations, mirroring new controls in the GUI:

- **SYNC_WITH_SLAVE** – connects/disconnects to a slave instrument
- **SHOW_SLAVE_GUI** – shows/hides the slave GUI
- **SET_LINK_TO_SLAVE** – links/unlinks master and slave instrument configuration
- **SET_ACTIVE_LINKS** – sets the active link(s) for commands to master only, slave only, or both master and slave.
- **SET_DUAL_INTERFACE_MODE** – sets the dual-interface mode for video (i.e. defines how images are partitioned across master and slave).

One final RPC command, **SET_RPC_TARGET**, has been defined to enable communication with the slave via RPC communication with the master. This is necessary because the RPC port of the slave server GUI is already being used for ongoing master/slave GUI communication.

**SET_RPC_TARGET** sets the final destination for subsequent RPC commands (master or slave). For example, to toggle the trigger out signal on the slave, you could send the following command sequence:

1. **SET_RPC_TARGET 1**
2. **FORCE_TRIG 2**
3. **SET_RPC_TARGET 0**

Note that the need for RPC communication with the slave is minimal. MIPI Commands are generally sent on the slave using the **SET_ACTIVE_LINKS** command rather than directing them to the slave directly. And most configuration commands sent to the slave will be negated once the master overwrites settings upon the next MIPI command.
However, there are two common reasons for communicating with the slave via RPC. They are:

1. When SET_LINK_TO_SLAVE is false. Then instrument configuration commands (to set voltages, delays, etc.) are necessary to control the slave.
2. To get slave status such as DUT response, contention, GP input state, etc.

### 5.15 Customizing GUI Colors

In the DPhyGenCtl, the user can configure the colors of various elements of the GUI (e.g. the background and foreground colors of buttons, forms, menus, etc). This is achieved using the Color Options dialog, brought up via the Options menu by selecting the “Set Colors” menu item.

The Options dialog (see Figure 15) consists of a column of buttons on the left showing the current color settings of GUI controls. In the center of the dialog is a color square showing all the colors associated with a given luminance. Clicking and dragging the mouse inside of the color square selects the color of the currently selected control.

![Color Options Dialog](image)

**Figure 15 – Color Options Dialog**

The luminance can be changed by adjusting the slider labeled ‘Y’. Alternately, you can change the R, G, B color components using the sliders on the right of the color square. Yet another way to change the color is to click on a control button color (far right column). This loads the selected color as the current color. For example, to set the
Button foreground the same as the Form foreground, click the Button FG radio button and click the color button next to the Form FG button.

As the control color changes, the main window colors changes in real time, so you can see how colors interact. To restore the default colors, click on the Defaults button. When you are done changing colors, to accept the new colors, click the OK button. To discard your color changes, click the Cancel button. Color settings are saved on application exit and restored when the application is restarted.

5.16 GUI Options
The Options->Set GUI Options… menu item brings up a dialog to selectively enable/disable common warnings and configure behaviors in the application (see Figure 16). Options are self-explanatory.

![GUI Options Dialog](image)

**Figure 16 – GUI Options Dialog**

5.17 Keyboard Shortcuts
A few keyboard shortcuts are available when the main window is active. A dialog listing them can be brought up using the Ctl-K key sequence (see figure):
Figure 17 – Keyboard Function Dialog

Note that the view image and DSC compression functions apply to the current File Name for the current command.

5.18 Menus

This section outlines the menu commands available in DPhyGenCtl:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILE MENU</td>
<td></td>
</tr>
<tr>
<td>Load…</td>
<td>Loads a previously saved command configuration file, overwriting any current commands and button assignments.</td>
</tr>
<tr>
<td>Save &lt;fn&gt;…</td>
<td>Saves the current command definitions and button assignments from both the CSI and DSI protocol sets to the current configuration file name. Note that the command configuration file does NOT store application settings, including options, DPhy configuration, PG configuration, and frame timing configuration settings.</td>
</tr>
<tr>
<td>Save &lt;fn&gt; As…</td>
<td>Same as the Save command above except a dialog appears to browse for and enter a new configuration file name.</td>
</tr>
<tr>
<td>Run Script…</td>
<td>Brings up a file dialog to select an RPC script file to run. This is equivalent to selecting the “RPC Script” command in the Pkt Type control, entering the script file name as its argument, and clicking the send button.</td>
</tr>
<tr>
<td>Send Cmd To PG File</td>
<td>Builds a compiled binary PG file containing the program associated with the current command. The PG file can then be subsequently sent using the PG File command (see section 5.11).</td>
</tr>
<tr>
<td>Restore Factory Defaults…</td>
<td>Restores all application defaults including commands and button assignments.</td>
</tr>
<tr>
<td>&lt;recent files&gt;</td>
<td>Lists the four most recent configuration files. Selecting one of these file names loads the file.</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear Recent File List</td>
<td>Clears the most-recent-file-list.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits the application.</td>
</tr>
</tbody>
</table>

**CONNECT MENU**

| Connect… | Brings up the PG connection dialog (see section 5.3). |
| Disconnect | Disconnects from the current instrument, putting the application in offline mode. |
| Sync with Slave… | Brings up the Slave Sync Dialog to launch a second instance of DPhyGenCtl, operating as the slave server application for a second P344 instrument. |
| Show Slave GUI | Shows/hides the slave server GUI |
| Enable RPC… | When checked, enables the application to accept and process incoming RPC requests (see the DPhyGenCtlRPC manual for more information). |
| Update Firmware… | Updates DPhy Generator firmware (see section 5.13.10). |

**STANDARD MENU**

| DSI | Selects the DSI command set and button assignments. |
| CSI | Selects the CSI command set and button assignments. |

**OPTIONS MENU**

<p>| Loop Commands | When checked, causes commands (except for video-mode commands) to be looped for a specified count or indefinitely. When this option is checked, a dialog requests the user to enter a Loop Count argument, specifying the number of times to send commands on the bus. A loop count of 0 can be entered for infinite looping, which can be stopped with the Stop PG button. Note that video-mode commands are either sent once or continuously as specified by the Play Mode control in the Timing Configuration dialog. However, video-mode frames can be added to macros that, in turn, can be looped a specific number of times using this menu option. So, no functionality is lost. |
| Wait on external event to start | When checked, configures the PG to wait for an external event on its Evt1 input before outputting a sent command. When the event input is a logic ‘0’, the PG waits until it goes to ‘1’ before continuing (see section 5.13.4 for more information). Note that the external event can also be used to control macro output using the “Wait Ext Event” packet type. See section 5.13.4. |
| Disable event timeout | When checked, disables the normal timeout for wait events during program output, such as for a BTA response, BTA |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>acknowledgement, and external events</td>
<td>This option is particularly useful for macros that include SEND_BTA, BTA_WAIT or WAIT_EXT_EVENT commands, which can cause arbitrary delays based on the testing environment and the behavior of the device under test. See section 5.13.6.</td>
</tr>
<tr>
<td>Send BTA on all active lanes</td>
<td>When checked, causes a BTA sequence to be output on all active lanes rather than lane 0 only. In addition, the P344 will terminate all active lanes when an HS burst entry sequence is detected from the DUT on lane 0. This allows for correct multi-lane HS response behavior on the bus. Note: this is not a typical requirement for MIPI receivers and the P344 does NOT receive response data sent in HS mode.</td>
</tr>
<tr>
<td>Enable “Hold Trail” test mode</td>
<td>When checked, enables “Hold Trail” test mode, which causes single non-video, non-macro HS packets to hold their HSTrail value indefinitely when sent. See section 5.13.8.</td>
</tr>
<tr>
<td>Enable command insertion</td>
<td>When checked, sending a non-video command while a video-mode command is looping causes the packet to be inserted (once) into the vertical blanking interval without stopping video playback. If unchecked, sending any command while a video-mode command is looping causes DPhyGenCtl to confirm that the user wants to stop video playback to send the command. This function also works with a looping macro containing a command insertion point. See section 5.7.4.1.</td>
</tr>
<tr>
<td>Enable Video Mode In Macros</td>
<td>When checked, sending a video-mode command when defining a macro inserts the video frame into the macro. If unchecked, only a single video-mode packet is added to the macro.</td>
</tr>
<tr>
<td>Send single packet per HS burst</td>
<td>When checked, macros that contain consecutive HS packets will be sent in individual HS bursts (i.e. bracketed by the HS burst entry/exit sequence). Otherwise, consecutive HS packets will be sent in a single HS burst.</td>
</tr>
<tr>
<td>Allow Image Rescaling</td>
<td>When checked, this option causes images specified in a Write Memory or video-mode command to be rescaled to the current output frame dimensions before conversion to the appropriate pixel format. Output frame dimensions are specified by the HActive and VActive fields of the Frame Timing configuration. If this option is not checked, an error is thrown when a command is sent whose image argument does not have the current output frame dimensions.</td>
</tr>
<tr>
<td>Turn Clk On When Sending Non-Video Cms</td>
<td>When checked, the clock is automatically turned on before a non-video command is sent. Otherwise, the clock remains off unless required by the command sent (i.e. Clock On, HS command, video-mode command in macro). See section</td>
</tr>
<tr>
<td>4.3.</td>
<td>Turn Clk Off After HS Burst (Non-Video)</td>
</tr>
<tr>
<td></td>
<td>Send PPS with compressed video</td>
</tr>
<tr>
<td></td>
<td>Enable DSI scrambling</td>
</tr>
<tr>
<td></td>
<td>Enable CSI per-lane scrambling</td>
</tr>
<tr>
<td></td>
<td>Enable EoT packets</td>
</tr>
<tr>
<td></td>
<td>Encode RAW format as Bayer…</td>
</tr>
<tr>
<td></td>
<td>Configure DPhy timing…</td>
</tr>
<tr>
<td></td>
<td>Configure Write Memory Commands…</td>
</tr>
<tr>
<td></td>
<td>Configure DSC…</td>
</tr>
<tr>
<td></td>
<td>Set GUI Options…</td>
</tr>
<tr>
<td></td>
<td>Set Colors…</td>
</tr>
</tbody>
</table>

**SCRIPT MENU**

<p>|  | Start Recording… | Brings up a file dialog to select an output text file to save recorded script commands. Then, the application is put in script recording mode, which logs and outputs MIPI commands to the script file as they are sent to the DUT. See section 5.13.8. |
|  | End Recording | Ends script recording. |</p>
<table>
<thead>
<tr>
<th>Write Current State</th>
<th>Writes the application configuration state as RPC commands to the current script record file. If the application is not currently in record mode, the user is first prompted for a text file name to use for output.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write Current Cmds</td>
<td>Write all currently defined user-commands as RPC commands to the current script record file. If the application is not currently in record mode, the user is first prompted for a text file name to use for output.</td>
</tr>
</tbody>
</table>

**ABOUT MENU**

<table>
<thead>
<tr>
<th>Help…</th>
<th>Displays this manual as a help file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help RPC…</td>
<td>Displays the DPhyGenCtlRPC manual as a help file.</td>
</tr>
<tr>
<td>About…</td>
<td>Brings up a summary window displaying the current software version. This dialog also includes a summary of release notes of changes/fixes for each version</td>
</tr>
</tbody>
</table>
6 DPhyGenCtl RPC (Remote Procedure Calls)

To facilitate automated testing and remote control, DPhyGenCtl can respond to incoming RPC requests from other applications via a Microsoft .NET TCP server port. To support this function, a separate .NET DLL called DPhyGenCtlRPC.DLL is provided. Any programming language that can interface to a .NET DLL can use this automation capability.

Alternatively, RPC commands have a script form that can be used in a text script file and run from the DPhyGenCtl GUI. In this case, no external programming is required. Many customers use script files extensively as they are a very powerful and convenient tool to configure and control DPhyGenCtl and the DPhy Generator.

Two separate documents have been written to detail the RPC communication interface, supported commands, and example client code provided with installation of the DPhyGenCtl application. The documents are located in the application installation directory with shortcuts provided in the Start Menu. They are:

- DPhyGenCtlRPCCommands_<y>_<z>.xls – summary and description of all commands in the DPhyGenCtlRPC.DLL.

where <w>, <x>, <y> and <z> are the document version and release numbers. Please refer to this document for more information.

6.1 RPC Script Syntax Support

RPC Script files are text files that contain component RPC commands. Several features in DPhyGenCtl help the user with RPC script syntax:

1) Using the “Script->Start Recording” menu option prompts for a script file name to record MIPI commands that are sent. The word “Recording” is displayed in the status strip at the bottom of the main window when this mode is active. Once the desired commands are sent, select “Script->End Recording” to end the mode. The script file generated will contain proper RPC syntax for the commands sent.

2) Using the “Script->Write Current State” menu option writes the current state using a comprehensive set of RPC configuration commands to the current script file (if currently recording) or a designated script file (if not currently recording). This provides a useful example of RPC script syntax, an important method of documentation for users to help The Moving Pixel Company provide technical support, and also a tool for users to save and restore specific configurations for their own testing.
3) Using the “Script->Write Current Cmds” menu option writes all the current user-defined commands as RPC commands to the current script file (if currently recording) or a designated script file (if not currently recording).

6.2 Sending RPC Scripts

There are two ways to send a script file. The first is to define a command in the main window by selecting “Miscellaneous Commands->RPC Script” in the Pkt Type control and then entering the script file name in the File Name argument. Then, clicking the Send button causes the script to be executed. The second way is to use the “File->Run Script…” menu option, browsing and selecting the script file name in the file dialog that appears.

6.3 Internal File Support

Note that the RPC Script command, File command, and now any packet command that uses a data file, support a feature called an internal file. This feature allows component command text to be entered directly as the File Name argument for the command rather than a valid filename. The application considers the File Name to be an internal file if the first character is a “#” or the first two characters are “//”.

Internal files are parsed directly as component commands, exactly as the text contained in a file would be. Because multi-line editing is not possible in the File Name control, the user can click on the “…” associated button (normally used for file browsing) to display the internal file text in a text edit dialog. Note that the File Name text must start with “#” or “//” before the text edit dialog will appear, so to start defining an internal file a new command, please type ‘#’ in the File Name control before clicking the “…” button.

Several buttons are provided in the text edit dialog:

- **File**: brings up a file dialog to select a file to use for inserting a quoted string containing the file path into the text at the cursor position. This is useful for building RPC commands that reference a file name.
- **Load**: brings up a file dialog to select a text file to import into the text control. Note that this operation discards existing text in the control.
- **Save**: brings up a file dialog to save the dialog text to a text file.
- **Font+**: increase the font size of the text control
- **Font-**: decrease the font size of the text control
- **Clear**: clears the text in the dialog.
- **OK**: accepts the changes made to the text and closes the dialog.
- **Cancel**: discards the changes made to the text and closes the dialog.